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Document History

The following table provides an overview on the most important document changes.

Caution

Before you start the implementation, make sure that you have the latest version of this document. You can find
the latest version at http://help.sap.com/nw74 |i Installation and Upgrade 3.
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1 Getting Started

11 About this Document

This Upgrade Master Guide provides a central starting point for the technical upgrade to SAP NetWeaver 7.4
including Support Releases 1 (SR1) and 2 (SR2). It outlines the overall upgrade process, and refers you to the
required detailed upgrade documentation, installation documentation, and SAP Notes.

Caution

The Upgrade Master Guide is regularly updated. Make sure that you have the latest version by checking http://
help.sap.com/nw74 | Installation and Upgrade 3 immediately before starting the update or upgrade.

1 Note
Support Releases and Support Packages

If you install SAP NetWeaver 7.4 with Support Release 2, you install automatically the previously available
support packages 1to 8 at once, and your system goes immediately to 7.4 SP8 without needing to implement
the intervening SPs separately.

SAP NetWeaver 7.4 with Support Release 1 includes the support packages 1to 5. If you perform an update with
target release NW 7.4 SR1, your system goes immediately to 7.4 SP5.
Constraints

The business scenarios that are presented here serve as examples of how you can use SAP software in your
company. The business scenarios are intended only as models and do not necessarily run the way they are
described here in your customer-specific system landscape. Check your requirements and systems to determine
whether these scenarios can be used productively at your site. Furthermore, we recommend that you test these
scenarios thoroughly in your test systems to ensure that they are complete and free of errors before going live.

See Also

The technical implementation of this SAP solution is described in the document Master Guide — SAP NetWeaver
7.4. The Master Guide is available at http://help.sap.com/nw74 | Installation and Upgrade 3.

1.2 Glossary

Short overview of some technical terms as well as SAP NetWeaver key terms:

1 Note

Usage Type, Technical Usage, and Product Instance

SAP NetWeaver Upgrade Master Guide
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The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
#ir . Note that there is no terminology change for older releases and all mentioned terms can be used as

synonymes.

Table 2:

Term

Client

Explanation

Clients are additional installable programs or tools. They reside either on local front-end PCs
accessed by users or on back-end systems where they act as client programs within an SAP
NetWeaver system landscape.

Functional Unit

A configured and activated unit of SAP NetWeaver that provides a set of functions, allowing
the implementation and execution of activities such as process steps within IT scenarios. Itis
nestable and can be grouped into larger functional units. Examples include transport manage-
ment system, system landscape directory, adapter framework, and business process engine.

Landscape Pattern

Defines if a technical system is used by one or several product systems to calculate update
and upgrade methods. The landscape pattern can be defined as “hub” system (if used by sev-
eral product systems) or as “sidecar” system (if used by one product system).

LMDB

Landscape Management Database

Central storage and editor for system information in SAP Solution Manager, supplied by a
central SLD. In the LMDB, you manage technical information (such as technical systems and
hosts) and logical information (such as product systems and technical scenarios). This data
is the basis for other applications, like monitoring and alerting, diagnostics, maintenance
transactions, and SAP Support Portal.

As of SAP Solution Manager 7.1, the LMDB replaces the previous information storage SMSY.

Logical Component

Group of technical systems that provide a concrete business function by installed product in-
stances and by different roles (such as development, test or production system).

Maintenance Optimizer
(MOpz)

Application within SAP Solution Manager that guides you through planning and downloading
stack XML files for enhancement packages, support packages, and additional update pack-
ages. These files can be used as input files for the installation by update tools like Software
Update Manager.

Product

An SAP offering in the SAP price list that performs business tasks.

The complete product model is shipped as SAP Software Catalog. The availability of products
is published in the Product Availability Matrix (PAM). The product model defines the product
structure with its product instances, software components, version, and technical dependen-
cies between product and its components. Products typically have a name starting with
'SAP..." and are characterized by a version period and a maintenance cycle. A product can be
installed on one or more technical systems. All technical systems that are involved form the
product system.

Examples for products are SAP ERP, SAP NetWeaver, and SAP Solution Manager.

SAP NetWeaver Upgrade Master Guide
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Term

Product Instance

Explanation

Part of a product version that bundles one or more software components.

A product instance is part of only one product version. It must be installed and updated as a
whole on a single technical system. (ABAP-Java dual-stacks are considered one technical
system.) Patches can still be installed for individual software components. A product instance
can contain other product instances. It can be re-used across products.

Examples for product instances are SAP ECC Server and SAP NetWeaver AS ABAP.

Product System

A group of technical systems on which a product version is installed. Product system descrip-
tions are used to maintain and plan products in the system landscape.

Product Version

A release of an SAP product.

It bundles product instances and the included software component versions that are available
at a particular time for a specific scope of functionality. Like products, product versions are
shipped in the SAP Software Catalog. They are the basis for the compatibility of closely cou-
pled systems and the maintenance of product systems.

An example is SAP ERP 6.0, which is a product version of the product SAP ERP.

Optional Standalone Units

Optional standalone units are additional software units that you install separately. They are
based on Application Server Java (AS Java) and provide specific (server) functions in combi-
nation with one or more SAP systems.

SLD

System Landscape Directory

Central provider of information on technical systems, for consumers in the system landscape
and for external consumers. The SLD gets its information mainly from SLD data suppliers,
which are installed on the technical systems, and from the SAP software catalog.

With the SLD, you collect and edit system data that is required for system landscape manage-
ment. This information can be used by other consumers, such as SAP Process Integration,
WebDynpro for Java, and SAP Solution Manager.

SMSY

The SAP Solution Manager System Landscape collects information about the SAP systems in
the landscape. (SMSY is the name of the transaction in SAP Solution Manager.) As of SAP
Solution Manager 7.1, the new information storage LMDB replaces SMSY.

Software Component

Delivery and product unit of an SAP software product

A software component comprises a set of packages that are delivered in a single unit. You al-
ways assign repository objects to a software component by assigning the package containing
these objects. This makes it possible to move repository objects from one software compo-

nent to another during a release upgrade. A software component is released in successive re-
leases with new functions. You can import patches into each software component separately.

Software Provisioning Man-

A tool that performs software provisioning processes such as installation, uninstallation, sys-

ager tem copy, or system transformation. The Software Provisioning Manager is delivered with the
Software Logistics Toolset.
SAP NetWeaver Upgrade Master Guide
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Term

Stack configuration file

Explanation

The stack configuration file is created by the Maintenance Optimizer and is system-specific.
Depending on the software components that are installed in a system, the Maintenance Opti-
mizer calculates the required software components that have to be updated to reach a cer-
tain target configuration.

Standalone Engine

Standalone engines of SAP NetWeaver are additional installable software units. They do not
work as full-blown systems of SAP NetWeaver, but as standalone engines that provide a spe-
cific (server) function in combination with one or more SAP NetWeaver systems. Standalone
engines are not part of a product instance. They do not run on AS ABAP or AS Java.

Technical System

Describes a part of a product's software that is installed on one or several physical or virtual
hosts.

A technical system is installed and administered as a whole. It is identified by a system ID
(SID) or extended SID, a host, and an installation number. There are different technical sys-
tem types, for example Application Server (AS) ABAP, AS Java, or TREX. Technical systems
are central elements when it comes to software component deployment and operational ac-
tivities, such as monitoring and alerting.

Update

Activities to maintain or enhance a system, such as installing enhancement packages, instal-
ling add-ons, or applying Support Package stacks or Support Packages.

Note: The tool for system maintenance tasks is the Software Update Manager (SUM). In the
SUM guide, the term "Update" is used as collective term for all the tasks that can be per-
formed using this tool (such as performing release upgrades, installing enhancement pack-
ages, or updating a system with Support Package Stacks).

Upgrade

The switch from an older software version to a new version. Typically, both the server compo-
nent of a system landscape and other components are upgraded. Several different technical
upgrade procedures are used to upgrade the server component, such as the Repository
Switch upgrade or the System Switch upgrade.

Usage Type

An installed and correspondingly configured part of an SAP NetWeaver system that provides
key capabilities for a system landscape. It specifies the intended purpose of a system, and it is
the result of the configuration of the underlying installed software units and the configuration
of the underlying functional units.

Examples include business intelligence, process integration, and enterprise portal.

Use Case

A definition of use from the end users' perspective for accomplishing a specific goal within a
system. Use cases represent the main capabilities of the system to fulfill specific require-
ments.

SAP NetWeaver Upgrade Master Guide
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1.3 SAP NetWeaver Use Cases

Use

The use cases illustrate how you can use your SAP NetWeaver implementation. The main use cases of SAP
NetWeaver and their corresponding key areas of SAP NetWeaver are as follows:

Table 3:
Use Case Corresponding Key Area of SAP NetWeaver
Building Composite Applications SAP Composition Environment
Data Warehousing SAP Business Warehouse
Building Integration Scenarios SAP Process Integration

Integrating and Self Servicing Content with SAP Enterprise SAP Enterprise Portal

Portal
Mobilizing Business Processes SAP NetWeaver Mobile
Custom Application Development (ABAP) (All areas that allow ABAP development on the SAP NetWea-
ver Application Server ABAP)
Constraints

As of SAP enhancement package 1 for NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on to SAP
NetWeaver. For more information see SAP Note 1645275 .

More Information

You can get all information about the key areas with regard to SAP NetWeaver 7.4 in the SAP Help Portal and in
the SAP Community Network (SCN):

e SAP Help Portal
SAP Help Portal bundles access to SAP product documentation and also related information, such as SAP
Notes, product availability information, as well as community content.
For SAP NetWeaver 7.4, you access the Help Portal using the address http://help.sap.com/nw74 #e .

1. Choose | Application Help » <key area> A for instructions for using the application.
2. Choose |l Application Help » Function-Oriented View » <functional area> 3 for a component-based
reference of all functions and tasks that can be performed with the product.

e SAP Community Network (SCN)
The SCN is organized into more than 300 “spaces”, which support small, self-contained communities. These
communities are typically focused around a topic, an SAP product, or an industry. Each space contains a

SAP NetWeaver Upgrade Master Guide
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complete set of social networking tools including a discussion forum, a blogging area, and an area where you
can publish and collaborate on documents.

As alogged-on member, you can go to any space in the SCN landscape but it's likely that you will be
interested in visiting and following a particular set of spaces that reflect your particular range of interests and
where members who share your interests are likely to hang out.
SCN spaces are where you get the latest news from SAP and the community, where you interact with your
peers, where you earn points for your contributions, and where you establish reputation as being expert on
certain topics
You access the SCN using the address http://scn.sap.com .

1. Tolearn more about SAP NetWeaver, choose:

o |» Products » tab “Technology” » Application Foundation/Integration » SAP NetWeaver » SAP
NetWeaver 3 or
o |» Lines of Business » Information Technology » SAP NetWeaver 3

o http://scn.sap.com/community/netweaver i

2. Moreover, the SAP Community Network provides you with detailed information regarding the SAP
NetWeaver use cases:

Table 4:

For the use case choose in the SCN Community:

Integrating and Self Servicing Content with SAP Enterprise » Products > tab “Technology” > Application Foundation/

Portal ) o
Integration > SAP NetWeaver > Team Productivity > SAP

Enterprise Portal |

or choose http://scn.sap.com/community/enterprise-portal

i

Data Warehousing |\ Products # tab “Technology” ¥ Application Foundation/
Integration } SAP NetWeaver > Information Management >
SAP Business Warehouse ]

or choose http://scn.sap.com/community/data-warehous-
ing/bw e

Building Composite Applications |» Products # tab “Technology” ¥ Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >

Business Process Management }

or choose http://scn.sap.com/community/bpmfr

Custom Application Development |» Products # tab “Technology” # Application Foundation/
Integration > Custom Development > ABAP Development >
ABAP Development 3

or choose http://scn.sap.com/community/abap#r

SAP NetWeaver Upgrade Master Guide
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For the use case choose in the SCN Community:

Mobilizing Business Processes | Products # tab “Technology” ¥ Enterprise Mobility
Enterprise Mobility |

or choose http://scn.sap.com/community/mobile i

Building Integration Scenarios | Products # tab “Technology” ¥ Application Foundation/
Integration > SAP NetWeaver > Process Orchestration >
Process Integration & SOA Middleware ]

or choose http://scn.sap.com/community/pi-and-soa-mid-
dleware P

1.4 Business View of the Use Cases

For implementation and configuration purposes, the SAP NetWeaver use cases are structured according to the
business view of SAP's Software Portfolio. This portfolio is structured using elements such as

e Solutions

e Solution Editions

e Key Capabilities / Scenario Groups
® Scenarios / Processes

Various tools, services and processes, such as the Business Process Repository for the SAP Solution Manager,
use the business view of the SAP Software Portfolio.

The following table displays the structured business view of the use cases in the SAP Solution Manager:
Table 5:

Use Case Corresponds to Business Scenario Includes the Scenarios/Processes

Group/Key Capability

Building Composite Applications Building Composite Applications ® Business Rules Management
e Java Development and SOA Infra-
structure

® Process Composition

Data Warehousing Enterprise Data Warehousing e Data Modelling

e Define Data Flow

e Metadata Management

e Performance Optimization

e Scheduling and Monitoring

Building Integration Scenarios Building Integration Scenarios Building Integration Scenarios

SAP NetWeaver Upgrade Master Guide
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Use Case

Corresponds to Business Scenario

Group/Key Capability

Includes the Scenarios/Processes

Building integration-centric processes

Building integration-centric processes

using the single-SID Pl and BPM solution

Integrating and Self Servicing Content
with SAP Enterprise Portal

Integrating and Self Servicing Content
with SAP NetWeaver

Building Communities with Wikis &
Forums

Content Management Scenarios
with Knowledge Management
Managing and mashing up portal
pages with Web Page Composer
Portal Landscape Interoperability
and Openness

Unified Access to Applications and
Processes

Mobilizing Business Processes

Mobilizing Business Processes

Developing Mobile Applications for
Occasional Connection

Enabling Mobile Applications for Oc-
casional Connection*

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Application Lifecycle Management

Application Lifecycle Management

1.5 Mapping of Use Cases to Installable Software Units

To give you a quick overview of SAP NetWeaver 7.4, the table below shows the mapping between use cases of this
SAP NetWeaver version and required SAP NetWeaver software units. For details about the product instances, see
section Description of Software Units [page 88]. For more information about the use cases, see the Master

Guide - SAP NetWeaver 7.4.
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Table 6:

Use Case Product Instance Standalone Engines Optional Standalone Clients

Units

Building Composite Ap-
plications:

Business Rules
Management and
Process Composition

AS Java

Adobe Document
Services (optional)
Business Process
Management and
Business Rule
Management
Composite Appli-
cation Framework
Composition Envi-
ronment Platform
NW Product De-

SAP NetWeaver
Developer Studio
Visual Composer
Adobe LiveCycle
Designer (Op-
tional)

Web Browser

SOA Infrastructure

Enterprise Serv-
ices Repository

scription

DI [optional]
Building Composite Ap- AS Java SAP NetWeaver
plications: NW Product De- Developer Studio
Java Development and scription Web Browser

DI [optional]

Data Warehousing

AS ABAP

BW ABAP

AS Java

NW Product De-
scription [optional]
AS Java Exten-
sions [optional]

Bl Java [optional]
EP Core — Applica-
tion Portal [op-
tional]

Enterprise Portal
[optional]

Search and Classifica-
tion (TREX)

SAP GUI with Busi-
ness Explorer (BI
Add-On)

SAP BusinessOb-
jects Analysis, Edi-
tion for Microsoft
Office* [optional]
SAP BusinessOb-
jects Crystal Re-
ports* [optional]
SAP BusinessOb-
jects Dashboards
[optional]

SAP BusinessOb-
jects Web Intelli-
gence* [optional]
SAP BusinessOb-
jects Design Stu-
dio* [optional]

14 PUBLIC
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Use Case

Building Integration
Scenarios

Product Instance

e Application Server

Java

e NW Product De-
scription

e AS Java Exten-
sions

e Application Server
ABAP

® Process Integra-
tion

e Enterprise Serv-
ices Repository

® Process Integra-
tion Adapter En-
gine

Standalone Engines

Adapter Engine
(Java SE) [op-
tional]

Optional Standalone
Units

e Advanced Adapter
Engine [optional]

e Advanced Adapter
Engine Extended

Clients

Integrating and Self
Servicing Content with
SAP Enterprise Portal:

e ASJava

e NW Product De-
scription

e AS Java Exten-
sions

e EP Core - Applica-
tion Portal

e EP

e Portal Add-on (for
Building
Communities with

Occasional Connectivity

e EP Core — Applica-
tion Portal [op-
tional]

Wikis and Forums
only)
Mobilizing Business e ASABAP e SAPGUI
Processes: e Mobile e SAP NetWeaver
Developing Mobile e Application Server Developer Studio
Applications for Java ® Mobile Client
e DI

SAP NetWeaver Upgrade Master Guide
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Use Case Product Instance Standalone Engines Optional Standalone Clients
Units
Mobilizing Business e ASABAP e SAPGUI
Processes: ® Mobile e SAP NetWeaver
Enabling Mobile e Application Server Developer Studio
Java e Mobile Client

Applications for

Occasional Connectivity | ® bl

e FEP Core - Applica-
tion Portal [op-

tional]

Custom Application e ASABAP e SAPGUI

Development e ABAP Develop-
ment Tools
(Eclipse)

SAP Knowledge Ware- | ® ASABAP e Search and Classi- e Web Browser

house e ASJava fication (TREX) e SAP GUI (KW Add-

e Content Server on included)

*Note that SAP BusinessObjects products require separate licenses.

1.6 Enhancement Packages

1.6.1 Enhancement Package Concept

We have adapted our major release strategy to better fit your adoption cycle. To ensure that you benefit from new
developments and innovations while minimizing the impact on your core operational systems, SAP uses
enhancement packages to speed up the delivery of new functions.

With SAP enhancement packages, you can install and activate new functions depending on your business needs
without having to perform a system upgrade.

You can selectively implement the new functions and activate the software upon business demand. As a result,
you can isolate the impact of software updates and make new functions available faster due to shortened test
cycles.

Implementation

There are three different scenarios to implement an enhancement package:

e |nstallation of an enhancement package on an existing SAP system

SAP NetWeaver Upgrade Master Guide
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® New installation of an SAP system including an enhancement package
e Upgrade of an SAP system including an enhancement package

Maintenance

SAP enhancement packages have Support Packages of their own that are equivalent to the Support Package
versions of the underlying SAP system. We highly recommend installing the enhancement package in
combination with the latest available Support Package stack. This approach reduces installation, modification
adjustment, and testing effort. Using this strategy, you can install SAP enhancement packages as a normal
maintenance activity together with Support Package stacks.

An enhancement package requires a specific Support Package stack level in the source release SAP system.

1 Note

If the SAP system is on a lower Support Package stack level, all relevant Support Package stacks for the
enhancement package installation are automatically included into the download queue by the Maintenance
Optimizer, as well as the latest available Support Packages for the enhancement package.

For a better understanding of the general concepts and principles of updating a system, see the Maintenance

Planning Guide at http://support.sap.com/mopz#& | section “Guides" 3

Tools

The enhancement package installation requires the following tools:

1. SAP Solution Manager

1 Note

Use of SAP Solution Manager is mandatory.

Tool versions:

We recommend to always use the latest version of the SAP Solution Manager. For more information, see SAP

Support Portal at http://support.sap.com/solutionmanager #r.
System Landscape Maintenance with SAP Solution Manager:

Make sure that you have correctly defined and maintained your system landscape in SAP Solution Manager:

o  SAP Solution Manager 7.0: Use the SAP Solution Manager System Landscape (transaction sMsy) for the

complete system description.

o SAP Solution Manager 7.1 SP0O1 to SP0O4, use the Landscape Management Database (transaction LMDB)
to maintain technical system information. For logical product system information, use transaction smMsy.

o SAP Solution Manager 7.1 SPO5 and higher, use the Landscape Management Database (transaction
1L.MDB) for the complete system description. (The transaction sMSY is no longer required.)

For more information about the Landscape Management Database (LMDB), see http://help.sap.com/
solutionmanager71#%|» Application Help » SAP Library SAP Solution Manager 7.1 <SP version> » SAP

SAP NetWeaver Upgrade Master Guide
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Solution Manager Operations » Landscape Management Database (LMDB) » Managing System Landscape

Information 4.

Landscape Verification with SAP Solution Manager:

To verify and correct your system landscape, SAP highly recommends that you use the verification functions
of the SAP Solution Manager:

= Recommendation

Before installing the enhancement package, we recommend that you run a landscape verification to check
your landscape setup and your system descriptions, and to correct data if necessary.

o SAP Solution Manager 7.0 to 7.1 SPO4: Use Landscape Verification 1.0 for SAP Solution Manager. This
add-on allows you to identify and correct issues in your SAP Solution Manager landscape (transaction
SMsSY) before they cause problems, for example during a system update. Examples for errors are a
missing connection to the System Landscape Directory or the wrong assignment of products to technical
systems. For each type of error, a generic description for the solution is provided.

o SAP Solution Manager 7.1 SPO5 or higher: Use the landscape verification function that is embedded into
the product system editor of the Landscape Management Database (LMDB). It replaces the previous
Landscape Verification tool.

For more information about the landscape verification, see the SAP Community Network athttp://
scn.sap.com/docs/DOC-8793 .
2. Installation or upgrade tools (depending on your scenario)

o SAP Solution Manager Maintenance Optimizer (MOpz)

The SAP Solution Manager Maintenance Optimizer (MOpz) (accessible from the Change Management
work center) supports the download of a consistent queue that includes all necessary Support Packages
and enhancement packages. In addition, SAP Solution Manager calculates a valid import queue for the
selected SAP system and generates the enhancement package stack configuration file that you require
for the installation.

o Software Provisioning Manager 1.0
For the new installation of an SAP system including an enhancement package you use the standard
installation tool software provisioning manager 1.0.

o Software Update Manager (SUM)

Toinstall an enhancement package on an existing SAP system, as well as for the upgrade of an SAP
system to a higher release including an enhancement package, you use the Software Update Manager
(SUM).

1.6.2 Key Facts About Enhancement Packages

The following list summarizes important facts about the enhancement package concept and recommended
approaches:

e |nstall only selected parts of the enhancement package. The selection is driven by the functional need from a
business point of view.

® You cannot mix the installation of different enhancement package versions in your ABAP-based SAP system.
You can have just one enhancement package version in the SAP system. This means, if you have already
updated product instances to a previous EHP you need to apply the current EHP to those components as well.

e SAP enhancement packages are cumulative, meaning that each new enhancement package includes new
innovations of its own as well as all innovations delivered with prior packages.
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o \Werecommend installing the latest available enhancement package version.

e |nstall enhancement packages and Support Packages in one single step (this includes the preconditioned
Support Packages).

e SAP enhancement packages have Support Packages of their own that are equivalent to the Support Package
versions of the underlying SAP system.

e SAP enhancement packages have the same maintenance period as the underlying core application.

e The installation of an enhancement package is irreversible.

® Aslong as you do not activate a business function, the installation of an enhancement package has no impact
on existing business processes or user interfaces.
You can only activate business functions in ABAP-based systems, not in Java-based SAP systems.

® The activation of most business functions and extension sets is irreversible. Only a small number of business
functions is reversible.
Test the installation process and activation of new functions in advance on a sandbox system. Ensure that you
evaluate the runtime and the SAP system behavior, its dependencies and impacts. Make sure that your SAP
system is free of errors before going live.
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2 Upgrade at a Glance

2.1 The Overall Process at a Glance
Use

The following graphic shows the main steps that are involved in the process and which are explained below:

Maintainance of Update SAP Solution Manager to latest SP Level

System Landscape v
Data
Register Systems in SLD and Transfer Data to Solution Manager
\ 4
Complete System Descriptions in SMSY or LMDB

\ 4
Run the Landscape Verification (with Add-on or in LMDB)

Selection and Create Maintenance Transaction in the Maintenance Optimizer
Download

of Files
Selectthe Software Packages

\ 4
\ 4
] i ile (.

Calculate Stack Configuration File {.xml)

\ 4

Download Software Packages and Stack Configuration File

SAP System Planning and Preparation Activities
Upgrade v

Upgrade Procedure using Software Update Manager (SUM)

\4

. Follow-Up Activities

\ 4

Delta-Configuration of Systems

Figure 1: Overview of Main Steps of the Upgrade Process

1. You need the latest SAP Solution Manager system with the latest available Support Package stack level, and
the SAP Solution Manager Maintenance Optimizer needs to be configured.

2. You register your systems in the System Landscape Directory (SLD) and transfer the system data to SAP
Solution Manager.

3. You check and complete system data with transaction sMsy or LMDB and update them, if necessary.

4. You run the landscape verification in SAP Solution Manager with the Landscape Verification add-on or with
transaction L.MDB to check if the system data is sufficiently maintained to use the Maintenance Optimizer.
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8.
9.

As soon as the system data is maintained correctly, you start a new maintenance transaction with the
Maintenance Optimizer.

. As part of the maintenance transaction, you have to select the required software units you want to update as

well as the target Support Package level.

This selection is used by the Maintenance Optimizer to generate a stack configuration file and to calculate the
software components as well as the Support Packages.

You download the files using the Download Manager.

You plan and prepare the upgrade as described in SUM guide.

10. You upgrade the system using the Software Update Manager (SUM).
11. You carry out the follow-up activities as described in SUM guide and the NW74 update and upgrade guides.

12. You check the configuration of your system and perform the configuration of the delta, if necessary.

More Information

Regarding the SAP Solution Manager and the transactions sMsy and L.MDB as well as the landscape
verification, see also Enhancement Package Concept [page 16], section Tools.

For a better understanding of the general concepts and principles of updating a system, see the Maintenance
Planning Guide at http://support.sap.com/mopz#& | section "Guides" 3

For information about finding other referenced guides, see section Documentation References [page 82].

2.2 Documentation Reading Sequence

In the different phases of your upgrade or enhancement package implementation project, different documents
and information sources support you with information. We recommend to read the documents in the following
order which leads you from overview documentation to detailed documentation
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Figure 2: Reading Sequence for Upgrade and EHP Installation

2.3 Upgrade Paths: Upgrade or EHP Installation

From a technical point of view, either an upgrade or an enhancement package installation will be carried out to
achieve the target release SAP NetWeaver 7.4, depending on the technology and the start release.

The following table provides an overview about the possible upgrade paths from earlier releases:
Table 7:

Start Release Upgrade or Enhancement Package in- | Comment

stallation (EHP inst.)

e SAP NetWeaver 2004 (AS-ABAP No direct upgrade supported

6.40)
e SAP NetWeaver 7.0 ABAP: EHP inst. SAP NW 7.0 with Support Package 14 or
e SAP NetWeaver 7.0 including En- higher

Java: Upgrade
hancement Package 1

e SAP NetWeaver 7.0 including En-
hancement Package 2
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Start Release Upgrade or Enhancement Package in- | Comment

stallation (EHP inst.)

e SAP Composition Environment 7.1 | EHP inst.

e SAP Composition Environment 7.1
including Enhancement Package 1

e SAP Composition Environment 7.2

e SAP Process Integration 7.1 ABAP: Upgrade

e SAP Process Integration 7.1 includ- Java: EHP inst.

ing Enhancement Package 1

e AS ABAP 7.10 (Banking) Upgrade

e SAP NetWeaver 7.3 ABAP: Upgrade

Java: EHP inst.

e SAP NetWeaver 7.3 including En- EHP inst.
hancement Package 1

To perform both options, you use the Software Update Manager (SUM) .For more information, see section
Upgrade Tools [page 23].
= Recommendation

Check also the PDF-document SUM SP <version> paths for a graphical representation of the supported update
and upgrade paths, that are possible with the Software Update Manager. This document is attached to every
central Software Update Manager note. You can find the latest central SUM Note at: http://support.sap.com/

sltoolsett | System Maintenance » System Update Manager (SUM) <version> 1.

2.4 Upgrade Tools

SAP Solution Manager and SAP Maintenance Optimizer (MOPZ)

These tools for the upgrade to SAP NetWeaver 7.4 are described in this document in the Enhancement Package
Concept [page 16].

For further information about setting up and maintaining SAP Solution Manager for supporting the upgrade, see
Preparing SAP Solution Manager [page 41].

Software Update Manager (SUM)

From a technical point of view, either an upgrade or an enhancement package installation will be carried out to
achieve the target release SAP NetWeaver 7.4, depending on the technology and the start release. For an
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overview about the possible upgrade paths from earlier releases, see chapter Upgrade Paths: Upgrade or EHP
Installation [page 22].

To perform both options, you use the Software Update Manager (SUM). The Software Update Manager internally
calls the sapup tool for upgrade and enhancement package installation. SAP recommends that you download the
latest Support Package of the Software Update Manager as it contains latest corrections and is updated regularly.
The tool is delivered in regular intervals, independent from SAP application product shipments, via Software
Logistics Toolset (SL Toolset).

For more information about the SUM, see the SAP Service Marketplace at http://support.sap.com/sltoolset
|b System Maintenance ¥ Software Update Manager <Version> » Guides 3.

The following overview shows how the Maintenance Optimizer and the Software Update Manager work together:

o SAP Service Marketplace
<<
(%) Software
g Packages
2 - - > «—>
— +
Qo
T Tool sum
- Stack
.</ Configuration
‘ File
Landscape
. ] Verification

2a)” I
’—) <«———> smsYr
LMDB

SAP Solution Manager 7.0 SP23 or higher

@
s
S
o
®

Figure 3: How the Upgrade tools work together

Tools for Special Purposes

e Upgrade Dependency Analyzer
When you plan your upgrade, you can use the Upgrade Dependency Analyzer to check the existence of
upgrade dependencies between two separately installed SAP systems in your system landscape.
For more information, see SAP Service Marketplace at http://service.sap.com/udaft.

e Unicode Conversion
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If you want to upgrade a non-Unicode system to a Unicode system, you have to perform a special procedure
named “Combined Upgrade & Unicode Conversion (CU&UC)". For more information, see the SAP
Community Network at http://scn.sap.com/docs/DOC-8284 Fr .

e |[nstallation of Additional Java Product Instances
If you want to install additional Java product instances in your upgraded system, you use the Software Update
Manager. For more information and installation instructions, see a SUM guide for Java that is relevant for your
database and operating system: Update Guide — Updating SAP Systems Using Software Update Manager (for
Java), section Installing Additional Product Instances in an Existing SAP System.

2.5 Dual-Stack Split

Use

Before you perform an upgrade to SAP NetWeaver 7.4 and higher, you have to split your optional dual-stack
system (ABAP+Java system). For more information, see the SAP Community Network at:http://scn.sap.com/
docs/DOC-33703# .

Before you perform an upgrade of a pure SAP NetWeaver system to SAP NetWeaver 7.3 or SAP enhancement
package 1 for SAP NetWeaver 7.3, SAP recommends that you split your SAP dual-stack system. (A pure SAP
NetWeaver system is an SAP NetWeaver system that does not have SAP Business Suite components deployed.
For more information, see SAP Note 1816819 .)

This is due to the following:

e The dual-stack split procedure is available only for SAP NetWeaver 7.0 systems, SAP NetWeaver 7.3 systems,
and SAP NetWeaver 7.3 systems with SAP enhancement package 1.

e SAP Business Suite 7i2011, which is based on SAP NetWeaver 7.0 including Enhancement Package 3, is the
last SAP Business Suite release with dual-stack support. No upgrade or update of dual-stack SAP Business
Suite systems is supported to higher releases. For more information, see SAP Note 1816819 #& .

e Asofrelease 7.4, we strongly recommend to migrate to the single stack. No upgrade or update of optional
dual-stack SAP NetWeaver systems is supported to SAP NetWeaver 7.4 and higher. By way of exception,
dual-stack implementations can still exist in former SAP Process Integration (SAP PI) installations.

e However, note that a single-stack SAP Process Integration Java (Advanced Adapter Engine Extended) exists
that offers almost all features of classical dual-stack implementations. Therefore, you should investigate, if a
Java-only implementation of SAP Pl is a feasible approach for your use cases. Due to the harmonized
procesBusnis orchestration stack (SAP Pl and SAP BPM running on the same Java instance), stateful system-
centric processes can be developed using SAP Process Orchestration capabilities. Processes that are created
with ccBPM need to be redesigned and modeled with SAP Business Process Management (SAP BPM). For
more information about how to do this, see the SAP Community Network at: http://scn.sap.com/docs/
DOC-28803#r .

Caution
SAP BW powered by SAP HANA database

The dual-stack split is mandatory if you want to upgrade and migrate to SAP BW on SAP HANA database.
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Prerequisites

The dual-stack split procedure is valid for SAP dual-stack systems based on the following release levels:
SAP NetWeaver 7.0 SP14 or higher

SAP NetWeaver 7.0 including Enhancement Package 1 or 2 or 3

Features

You split a dual-stack system into one ABAP stack and one Java stack each with its own system ID using the Dual-
Stack split tool. This tool is part of the Software Logistics Toolset (SL Toolset) 1.0. See http://support.sap.com/

sltoolsetrr | System Provisioning » Split Option » Guide for Systems Based on SAP NW <version> 34 for more
information.

Integration

SAP Business Suite 7i2011 is the last SAP Business Suite release with Dual-Stack support. Only in few cases, Dual-
Stack is still required (SAP Solution Manager, SAP Process Integration). We recommend to move away from Dual-
Stack systems where possible.

Any Dual-Stack-Split-Tool functionality will be offered in the Software Logistics Toolset (SL Toolset). For the SL
Toolset offering and release schedule, see the SAP Note 1563579 # (Central Release Note for Software Logistics
Toolset 1.0).

More Information

e For more information about the discontinuation of optional dual-stack deployments, see SAP Community
Network at: http://scn.sap.com/docs/DOC-33703 ¥ .

e [For more information on the dual-stack split procedure offered by SAP, see the SAP Community Network at:
http://scn.sap.com/docs/DOC-25162F .

e For information about the Dual-Stack Split Tool refer to the Dual-Stack Split Guide at http://
support.sap.com/sltoolsetf | System Provisioning ¥ Split Option # Guide for Systems Based on SAP NW

<version> 1. This guide also informs about the current SAP Notes regarding the dual-stack split. They contain
the most recent information on the dual-stack split, as well as corrections to the dual-stack split
documentation.

e Forinformation about the use cases for splitting dual-stack systems, see SAP Note 1655335 .
e Forinformation about the dual stack support for Business Suite systems, see SAP Note 1816819 # .

e For more information about the Software Logistics Toolset in general, see SAP Note 1563579#% (Central
Release Note for Software Logistics Toolset 1.0).
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2.6 Transition from SAP NetWeaver 2004

Caution

As the extended maintenance of SAP NetWeaver 2004 has been terminated in 2013, an direct upgrade from
SAP NetWeaver 2004 to SAP NetWeaver 7.4 is not possible anymore. The following describes the main
differences between the SAP NetWeaver release 2004 and 7.4 for your information only.

Relation Between Scenarios and Use Cases

SAP NetWeaver 7.4 no longer uses technical scenarios as defined with SAP NetWeaver 2004 to describe the
capabilities SAP NetWeaver provides. Instead, a set of “use cases” illustrates how you can implement and use
SAP NetWeaver. Use cases provide a structured access to configuration information in SAP Solution Manager and
therefore ease the implementation process.

From the following table you can see how SAP NetWeaver 2004 technical scenarios translate into SAP NetWeaver
7.4 use cases.

Table 8:
SAP Business Information Warehouse (SAP BW) Data Warehousing
Bl Information Broadcasting Data Warehousing
SAP Enterprise Portal (SAP EP) Integrating and Self Servicing Content with SAP Enterprise
Portal
SAP Mobile Infrastructure (SAP MI) Mobilizing Business Processes
SAP Knowledge Warehouse (SAP KW) No specific use case in SAP NetWeaver 7.4; Knowledge Ware-

house is an integral part of AS ABAP and AS Java

SAP NetWeaver Development Environment: Development of | The preferred SAP NetWeaver version for custom application
ABAP applications development in ABAP is SAP NetWeaver 7.0 as part of the
SAP Business Suite. SAP Business Suite is based on SAP Net-
Weaver 7.0 and the features of AS ABAP included in SAP Busi-
ness Suite 7i2011 and SAP NetWeaver 7.4 have been aligned
to a great extent. Although AS ABAP is fully supported as a
development platform in SAP NetWeaver 7.4, we recommend
using the enhancement packages for SAP NetWeaver 7.0 for
ABAP development. For information about the enhancement
package availability, see SAP Service Marketplace at http://
support.sap.com/releasestrategy .

SAP NetWeaver Development Environment: Development of | Not described as a separate use case, part of the AS Java and
Java applications NWDI installation
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SAP NetWeaver 2004 - Technical Scenarios ’ SAP NetWeaver 7.4 - Use Cases

SAP NetWeaver Development Environment: Team-oriented Not described as a separate use case, part of the AS Java and

development of Java applications NWDI installation
SAP NetWeaver Development Environment: Development Not described as a separate use case, part of the AS Java and
with SAP NetWeaver Java Development Infrastructure NWDI installation

SAP NetWeaver Development Environment: Interactive Forms | Custom Application Development ABAP (Web Dynpro Devel-
based on Adobe software opment).

Note that the preferred SAP NetWeaver version for custom
application development in ABAP is SAP NetWeaver 7.0 as
part of the SAP Business Suite.

SAP NetWeaver Development Environment: Development of | Integrating and Self Servicing Content with SAP Enterprise
Portal iViews Using SAP NetWeaver Visual Composer Portal

SAP NetWeaver Development Environment: Development of | Integrating and Self Servicing Content with SAP Enterprise
Portal Content with PDK for .NET Portal

Installable Software Units

With SAP NetWeaver 7.0, usage types have been introduced. They replace the formerly known software
components, such as SAP Web AS ABAP. Usage types represent the capabilities of an SAP NetWeaver system
offered by a collection of installed and configured (technical) software components. A usage type defines the role
a system plays in a given scenario.

1 Note
Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
i . Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.

When you upgrade your SAP NetWeaver 2004 components to a SAP NetWeaver release lower than 7.4, the
components are mapped to the corresponding product instances and upgraded accordingly. Missing software is
deployed so that your system contains complete product instances after the upgrade.

In addition to SAP systems with product instances, there are additional SAP NetWeaver building blocks:
standalone engines and clients. See the Glossary [page 6] for a definition of these terms. For a description of
these software units, see Description of Software Units [page 88].

The following table provides an overview of the mapping between SAP NetWeaver 2004 components and the
software units of SAP NetWeaver 7.4.

Table 9:

SAP NetWeaver 2004 Components Building Blocks of SAP NetWeaver 7.4

SAP Web Application Server Components
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SAP NetWeaver 2004 Components

Building Blocks of SAP NetWeaver 7.4

SAP Web Application Server ABAP 6.40

Application Server ABAP (AS ABAP) [product instance]

SAP Web Application Server Java 6.40

e Application Server Java (BASIC) [product instance]
e AS Java Extensions (AS) [product instance]

o NW Product Description (NW-MODEL) [product in-
stance]

Adobe Document Services

Adobe Document Services [product instance]

SAP GUI

SAP GUI [client]

SAP Internet Transaction Server (SAP ITS)

Included in Application Server ABAP (AS ABAP) [product in-
stance]

SAP Gateway

Gateway [standalone engine]

SAP NetWeaver Visual Composer

Part of Composition Environment Platform (CE-ENV) [prod-
uct instance]

PDK for .Net (Portal Add-In for Visual Studio 2005, Portal
Runtime for Microsoft .NET, Java-.NET Interoperability
Framework).

Part of EP Core — Application Portal (EPC) [product instance]

Forums Application

Part of Portal add-on

Search and Classification Components

Search and Classification (TREX)

Search and Classification (TREX) [standalone engine]

2.7 Transition from SAP NetWeaver 7.0

Caution

The upgrade to SAP NetWeaver 7.4 requires SAP NetWeaver 7.0 with Support Package 14 or higher.

Relation Between IT Scenarios and Use Cases

SAP NetWeaver 7.4 no longer uses IT scenarios as defined with SAP NetWeaver 7.0 to describe the capabilities
SAP NetWeaver provides. Instead, a set of use cases illustrate how you can implement and use SAP NetWeaver.
Use cases provide structured access to configuration information in SAP Solution Manager and therefore ease the

implementation process.
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From the following table you can see how SAP NetWeaver 7.0 IT scenarios translate into use cases for SAP

NetWeaver 7.4:

Table 10:

SAP NetWeaver 7.0 - IT Scenarios

SAP NetWeaver 7.4 - Use Cases

More Information

Running an Enterprise Portal

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 53]

Accelerating Global Delivery of Applica-
tion

Delivered as separate product — not
part of the SAP NetWeaver 7.4 shipment

For information about Accelerated Appli-
cation Delivery, see SAP Community
Network at http://scn.sap.com/
community/accad-for-netweaver P

Enterprise Knowledge Management:

Content Integration and Management;
Content Creation, Publication, and Ac-
cess

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 53]

Enterprise Knowledge Management:
Documentation, Training Materials and
Manuals Management

No specific use case in SAP NetWeaver
7.4; Knowledge Warehouse is an integral
part of AS ABAP and AS Java

Upgrade of SAP Knowledge Warehouse
[page 73]

Enterprise Search: Enabling Embedded
Search

No use case in SAP NetWeaver 7.4; Em-
bedded search is provided as part of AS
ABAP

Enabling User Collaboration

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 53]

Business Planning and Analytical Serv-
ices

Data Warehousing

Upgrade of Scenarios Based on SAP BW
[page 56]

Enterprise Reporting, Query, and Analy-
sis

Data Warehousing

Upgrade of Scenarios Based on SAP BW
[page 56]

Enterprise Data Warehousing

Data Warehousing

Upgrade of Scenarios Based on SAP BW
[page 56]

Enabling Application-to-Application
Processes

Building Integration Scenarios

Upgrade of Scenarios Based on SAP
Process Integration [page 61]

Enabling Business-to-Business Proc-
esses

Building Integration Scenarios

Upgrade of Scenarios Based on SAP
Process Integration [page 61]

Business Task Management

Building Composite Applications

Upgrade of Scenarios Based on SAP
Composition Environment [page 68]

Enabling Enterprise Services

Building Integration Scenarios

Upgrade of Scenarios Based on SAP
Process Integration [page 61]
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SAP NetWeaver 7.0 - IT Scenarios

SAP NetWeaver 7.4 - Use Cases

More Information

Developing, Configuring, and Adapting
Applications:
e Developing Java Applications using
Web Dynpro
e Creating Composite Applications

e Creating Applications Using SAP
NetWeaver Visual Composer

Building Composite Applications

Upgrade of Scenarios Based on SAP
Composition Environment [page 68]

Developing, Configuring, and Adapting
Applications:

e (Creating Business Applications Us-
ing ABAP

e Developing ABAP Applications Us-
ing Web Dynpro

The preferred SAP NetWeaver version
for custom application development in
ABAP is SAP NetWeaver 7.0 as part of
the SAP Business Suite. SAP Business
Suite is based on SAP NetWeaver 7.0
and the features of AS ABAP included in
SAP Business Suite 7i2011 and SAP Net-
Weaver 7.4 have been aligned to a great
extent. Although AS ABAP is fully sup-
ported as a development platform in
SAP NetWeaver 7.4, we recommend us-
ing the enhancement packages for SAP
NetWeaver 7.0 for ABAP development.

For information about the enhancement
package availability, see http://

support.sap.com/releasestrategy .

Developing, Configuring, and Adapting
Applications: Leveraging Java 2 Plat-
form, Enterprise Edition (J2EE) Stand-
ards for Porting and Adopting Applica-
tions

Not described as a separate use case in
SAP NetWeaver 7.4, part of AS Java and
Dl installation.

Developing, Configuring, and Adapting
Applications:

Developing Mobile Applications for Oc-
casional Connection

Mobilizing Business Processes

Upgrade of Scenarios Based on SAP
NetWeaver Mobile [page 70]

Developing, Configuring, and Adapting
Applications:

Creating Portal Applications Using PDK
for NET

Integrating and Self Servicing Content
with SAP Enterprise Portal

Upgrade of Scenarios Based on SAP En-
terprise Portal [page 53]

SAP NetWeaver Operations

The Adaptive Computing Controller
which was part of the SAP NetWeaver
Operations IT scenarios, is delivered as a
separate product.

For more information about the Adaptive
Computing Controller, see SAP Com-
munity Network at http://scn.sap.com/
docs/DOC-8646
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SAP NetWeaver 7.0 - IT Scenarios SAP NetWeaver 7.4 - Use Cases More Information

Software Life-Cycle Management No separate use case described for SAP
NetWeaver 7.4, lifecycle management
capabilities of SAP NetWeaver are part
of every installation.

Mobilizing Business Processes Mobilizing Business Processes. Upgrade of Scenarios Based on SAP
NetWeaver Mobile [page 70]

Authentication and Single Sign-On No separate use case defined in SAP
NetWeaver 7.4.

For information about authentication
and single sign-on, see SAP Help Portal
at http://help.sap.com/nw74

|+ Application Help » Function-Oriented
View > Security > User Authentication
and Single Sign-On 4

Integrated User and Access Manage- No separate use case defined in SAP
ment NetWeaver 7.4.

For information about Integrated user
and access management, see SAP Li-
brary at http://help.sap.com/nw74#

I» Application Help » Function-Oriented
View > Security > Identity
Management ]

Changes in Usage Types

1 Note
Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
i . Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.

Compared to SAP NetWeaver 7.0, some additional product instances are available with SAP NetWeaver 7.4. For
example, SAP NetWeaver Composition Environment has been integrated into the SAP NetWeaver platform.

When you upgrade your SAP NetWeaver 7.0 systems, the source release usage types are mapped to the
corresponding target release product instances. The following table shows which product instances will be in your
system after an upgrade to SAP enhancement package for NetWeaver 7.3 depending on the source release usage

types.
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Table 11:

SAP NetWeaver 7.0 - Usage Types ’ SAP NetWeaver 7.4 - Product Instances
Application Server Java e Application Server Java (BASIC)

e Application Server Java Extensions (AS)

e NW Product Description (NW-MODEL)

e Adobe Document Services (ADOBE)

e Composite Application Framework (CE-APPS)
Process Integration ® Process Integration (PI)

e Advanced Adapter Engine (PI-AF)

e Enterprise Service Repository (ESR)
Development Infrastructure e Development Infrastructure (DI)
Enterprise Portal e Enterprise Portal (EP)

e Composition Environment (COMP-ENV)
Enterprise Portal Core e EP Core — Application Portal (EPC)

e Guided Procedures (CE-PROCESS)
Bl Java e Bl Java (Bl

2.8 Transition from SAP NetWeaver Pl 7.1

Use Case

The SOA-Based Integration use case has been renamed to Building Integration Scenarios.

Software Units

Compared to SAP NetWeaver 7.1, some additional product instances are available with SAP NetWeaver 7.4, for
example, SAP NetWeaver Composition Environment has been integrated into the SAP NetWeaver platform. The
following table shows which product instances will be in your system after the upgrade.

Table 12:

SAP NetWeaver Process Integration 7.1 SAP NetWeaver 7.4

Process Integration (PI) ® Process Integration (PI)
e Advanced Adapter Engine (PI-AF)
e Enterprise Services Repository (ESR)
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SAP NetWeaver Process Integration 7.1 ’ SAP NetWeaver 7.4

Application Server Java e Application Server Java (BASIC)

e AS Java Extensions (AS)

o Adobe Document Services (ADOBE)

e Composite Application Framework (CE-APPS)
e NW Product Description (NW MODEL)

For more information, see Upgrade of Scenarios Based on SAP Process Integration [page 61].

1 Note
Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
. Note that there is no terminology change for older releases and all mentioned terms can be used as
synonyms.

2.9 Transition from SAP NetWeaver Mobile 7.1

In comparison to SAP NetWeaver Mobile 7.1, SAP NetWeaver Mobile is available as an add-on technology solution
for SAP NetWeaver as of SAP enhancement package 1 for NetWeaver 7.3. You install SAP NetWeaver Mobile
separately on top of an Application Server ABAP system, and you perform the related configuration and set up
tasks after the installation.

The functional scope of SAP NetWeaver Mobile 7.1 and SAP NetWeaver Mobile 7.1 including enhancement
package 1is covered by the Mobilizing Business Processes use case of SAP NetWeaver 7.4.

For more information, see Upgrade of Scenarios Based on SAP NetWeaver Mobile [page 70].

2.10 Transition from SAP NetWeaver Composition
Environment 7.1 and 7.2

SAP NetWeaver Composition Environment has been integrated into the SAP NetWeaver platform. The functional
scope is covered by the use case Building Composite Applications including the capabilities Business Rules
Management, Process Composition, Java Development and SOA Infrastructure.

Compared to SAP NetWeaver Composition Environment 7.1 and 7.1 including enhancement package 1, SAP
NetWeaver 7.4 includes a different set of product instances. When you upgrade system to SAP NetWeaver 7.4,
the source release usage types are mapped to the target release product instances and then the system is
upgraded accordingly.

SAP NetWeaver Composition Environment 7.2 and SAP NetWeaver 7.4 have the same usage type structure, so
there will be no changes when you upgrade your system except of the removal of the CE-Voice product instance.
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For more information, seehttp://help.sap.com/nw74 |» Application Help » Function-Oriented View »

Composition Environment » Compatibility and Removed Usage Types 4.

1 Note

Product Instance replaces Usage Type as of SAP NW 7.31

The term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on
SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731
#ir . Note that there is no terminology change for older releases and all mentioned terms can be used as

synonymes.

The following tables show the mapping of usage types SAP NetWeaver Composition Environment 7.1and 7.1
including enhancement package 1, respectively to the product instances of SAP NetWeaver 7.4.

Source Release SAP NetWeaver Composition Environment 7.1

Table 13:

SAP NetWeaver Composition Environment 7.1

SAP NetWeaver 7.4

Basic (BASIC)

e Application Server Java (BASIC)
e Demo Applications (BASIC-RA)
e CE Product Description (CE-MODEL)*

Composite Applications (CE-APPS)

Composite Application Framework (CE-APPS)

Composite Views (CE-VIEWS)

Composition Environment Platform (COMP-ENV)

Composite Voice (CE-VOICE)

Removed**

Composite Process (CE-PROCESS)

Guided Procedures (CE-PROCESS)*

Adobe Print Services (CE-ADOBE)

Adobe Document Services (ADOBE)

IDE Update Site (IDE-Update-Site)

NWDS Update Site (IDE-Update-Site)*

Enterprise Service Repository (ESR)

Enterprise Service Repository (ESR)

Source Release SAP NetWeaver Composition Environment 7.1 Including enhancement package 1

Table 14:

SAP NetWeaver Composition Environment 7.1 Including en-

hancement package 1

SAP NetWeaver 7.4

Application Server Java (BASIC)

e Application Server Java (BASIC)
e Demo Applications (BASIC-RA)
e CE Product Description (CE-MODEL)*

Composite Applications (CE-APPS)

Composite Application Framework (CE-APPS)

Composite Views (CE-VIEWS)

Composition Environment Platform (COMP-ENV)
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SAP NetWeaver Composition Environment 7.1 Including en- | SAP NetWeaver 7.4

hancement package 1

Composite Voice (CE-VOICE) Removed**

Guided Procedures (CE-PROCESS) Guided Procedures (CE-PROCESS)*

Adobe Document Services (CE-ADOBE) Adobe Document Services (ADOBE)

IDE Update Site (IDE-Update-Site) NWDS Update Site (IDE-Update-Site)*

Enterprise Service Repository (ESR) Enterprise Service Repository (ESR)

Business Process Management (BPEM) Business Process Management and Business Rules Manage-
ment (BPM)

BPM Portal Integration (BPEM-PP-Integration) Business Process Management and Business Rules Manage-
ment (BPM)

NW Development Infrastructure (NWDI) Development Infrastructure (DI)

* Note that CE Product Description, Guided Procedures, and NWDS Update Site are only provided for
compatibility reasons. These product instances are not included in a new installation of SAP NetWeaver 7.4. You
can install them directly from SAP Service Marketplace on top of a new SAP NetWeaver 7.4 installation. Guided
Procedures and NWDS Update Site have been replaced by newer technologies. CE Product Description illustrates
the usage of SAP NetWeaver Composition Environment for previous releases, so it is not relevant for SAP
NetWeaver 7.4.

For more information, see Upgrade of Scenarios Based on SAP NetWeaver Composition Environment [page 68]

** The Composite Voice (CE-VOICE) product instance is removed with SAP NetWeaver 7.4. For more information,
see http://help.sap.com/nw74ll Application Help # Function-Oriented View » Composition Environment »
Compatibility and Removed Usage Types 3.

2.11 Transition from SAP NetWeaver 7.3 and SAP EHP 1 for
NetWeaver 7.3

Use

SAP NetWeaver 7.4 is the compatible successor release of SAP NetWeaver 7.3 and SAP enhancement package 1
for NetWeaver 7.3. From a technical perspective, SAP NetWeaver 7.4 is positioned as an enhancement package
and follows all enhancement package rules with respect to compatibility and consumption.

SAP NetWeaver 7.4 is deployed on premise and serves as foundation for the Business Suite (both Business Suite
i2013 and Business Suite on SAP HANA). Therefore, this release was designed to provide optimized access to
SAP HANA and to leverage the consumption of native SAP HANA artifacts such as analytical views and database
procedures.
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Besides the optimization for SAP HANA, SAP NetWeaver 7.4 offers a wide range of additional capabilities
compared to NW 73/731. The following list emphasizes the highlights of the 7.4 release:

e |t comes with a fully integrated set of ABAP development tools for Eclipse to increase developer productivity,
and it offers an integrated development framework for the emerging HTML5 standard.

e The user interface has been harmonized with SAP NetWeaver Business Client 4.0 that offers a completely
new user experience based on tabbed browing, incremental search and content adaptation exposed in the
contextual Side Panel.

e |tdelivers flexible modeling capabilities for BW on SAP HANA. It lowers TCO and dramatically increases

performance and flexibility of SAP HANA deployments with integrated lifecycle management capabilities.
e |t provides backend connectivity to consumers of the OData protocol with embedded Gateway capabilities.
e |t delivers a new Portal experience with customized access to mobile users.

e |t facilitates unified Process Orchestration features running on a simple Java stack eliminating the need for
dual stack deployments. Integration scenarios can be monitored via SAP Solution Manager.
e |t fully enables single sign-on and identity federation.

More Information

For a complete list of all features and changes, see:,

e SAP NetWeaver 7.4 library at http://help.sap.com/nw74#%|» What s new — Release Notes. 3
e SAP Community Network at http://scn.sap.com/docs/DOC-35002
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3 Planning and Preparation

3.1

Major Planning Steps and Related Documentation

During an implementation project, you have to take into account many aspects and to take various decisions. The
major planning steps of this process are outlined below.

Table 15:

Step Description

Further Information

Scope and Requirements

You determine the scope of your SAP Net-
Weaver implementation.

For more information, see SAP NetWeaver
Use Cases [page 10].

Installable Software Units

You determine which installable software
units (that is, systems with product instan-
ces, standalone engines, optional stand-
alone units and clients) are required for the
use cases.

For more information, see the Mapping of
Use Cases to Installable Software Units
[page 13] section.

Landscape Planning

You determine the system landscape and
consider the landscape-relevant aspects
concerning your required use case.

See Upgrading Procedures for NetWeaver
Key Areas [page 53].

Hardware & Software Prerequi-
sites

Use the Product Availability Matrix (PAM) to
check which platforms (operating systems,
databases, browsers) are supported for
your SAP NetWeaver components.

http://support.sap.com/pam

Check the database dependencies and the

recommended minimum database versions.

See SAP Notes 1951491 %% and 1914052 #r .

Check which hardware sizing is required for
your SAP NetWeaver release.

http://service.sap.com/sizing®

Release Restrictions

Check SAP Notes for any release restric-
tions.

Regarding SAP NetWeaver 7.4 release re-
strictions, see SAP Note 1730102
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Step Description

Further Information

SAP Solution Manager Prerequi-
sites

We recommend to always use the latest
SAP Solution Manager release.

Make sure that your SAP Solution Manager
system has the required support package
level and content.

Check if you need to do an update or up-
grade of your SAP Solution Manager appli-
cation or content.

After an upgrade or update to the latest SAP
Solution Manager release, you need to do
follow-up actions described in the section
Software Change Management of the
Solution Operations Guide.

e See SAP Note 631042F% for informa-
tion about the Release strategy for Im-
plementation Content (ST-ICO).

e See SAP Note 781448#% for informa-
tion about Support Package levels of
SAP Solution Manager installations and
upgrades.

e The Solution Operations Guide for SAP
Solution Manager is available at:http://
service.sap.com/instguides®r [ SAP
Components # SAP Solution Manager

> <Release> > Operations }

3.2 Preparatory Activities

From a technical point of view, either an upgrade or an enhancement package installation will be carried out to
achieve the target release SAP NetWeaver 7.3 including enhancement package 1, depending on the technology

and the start release. If the start release is SAP NetWeaver 7.1 or higher and you use a dual-stack system or an AS
Java system, then it is handled as an enhancement package installation. For all other start releases and for AS
ABAP systems in general, it is handled on a technical level as an upgrade.

To perform both options, you use the Software Update Manager (SUM). General planning, preparation and follow-
up activities as well as the handling of the Software Update Manager (SUM) are described in the document Update
Guide — Update of SAP Systems Using the Software Update Manager <version> available at http://
service.sap.com/maintenancenw74#& or http://support.sap.com/sltoolset®|p System Maintenance »

Software Update Manager (SUM) <version> » Guides for SUM <version> 3.

In addition, you have to perform preparations and follow-up activities specific to your product instance. These
specific actions are described in this guide in the following sections.

Caution

You have to perform both the general preparation activities as well as the usage-type-specific preparations
before you can start the Software Update Manager. Make sure you start with these preparations in good time.
You can also consider performing these preparations in parallel to the preparation of SAP Solution Manager
and the download of the required software packages and the stack configuration file.

SAP Kernel Update

Make sure that you apply the latest Kernel on your target system as described in the SUM guide Update Guide -
Update of SAP Systems Using the Software Update Manager <version> available at http://service.sap.com/
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maintenancenw74# or http://support.sap.com/sltoolset# | System Maintenance » Software Update
Manager (SUM) <version> ¥ Guides for SUM <version> 3.

Support Package Stack (SPS)

As SAP NetWeaver 7.4 is only supported with Support Package Stack (SPS) 02 or higher, include at least SPS 02
into the upgrade. However, we highly recommend always installing the latest available Support Package Stack.

1 Note
Support Releases and Support Packages

If you install SAP NetWeaver 7.4 with Support Release 2, you install automatically the previously available
support packages 1to 8 at once, and your system goes immediately to 7.4 SP8 without needing to implement
the intervening SPs separately.

SAP NetWeaver 7.4 with Support Release 1 includes the support packages 1to 5. If you perform an update with
target release NW 7.4 SR1, your system goes immediately to 7.4 SP5.

SAP Notes for Preparing the Update or Upgrade

To prepare and perform the update of your SAP system, you require some additional information in a range of
SAP Notes in SAP Support Portal http://service.sap.com/notes .

You must read some of the notes, before you start with the preparations. Besides the central Software Update
Manager Note, there are separate SAP Notes for the database-specific sections. You must request the following
SAP Notes from SAP Support Portal before you start the update procedure:

e (Central Software Update Manager Note

e SAP Note for your database

During the upgrade, you may need information from some additional database-specific and database-
independent SAP Notes.

You find a list of these relevant SAP Notes in the following two guides, which you use in parallel considering your
specific combination of operating system, database and technology:

e Update Guide — Update of SAP Systems Using the Software Update Manager <version> available at http://
support.sap.com/sltoolset®|p System Maintenance ¥ Software Update Manager (SUM) <version>
Guides for SUM <version> 3

e Upgrade and Update Guide - SAP NetWeaver 7.4 available on the SAP Service Marketplace at http://

service.sap.com/maintenancenw74# | Upgrade - SAP NetWeaver Systems 4

The following SAP Notes provide you with important information for your SAP NetWeaver implementation project.
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Table 16: List of Important SAP NetWeaver Notes

SAP Note Number Title Description
1730102 "% Release Restrictions for SAP NetWeaver | Some restrictions apply to the produc-
7.4 tive use of SAP NetWeaver 7.4. These
are documented in this SAP Note.
1751237 #r Add. info about the update/upgrade to This SAP Note describes problems that
SAP (incl. SPs and SRs) may occur when you upgrade or update
your system and provides you with infor-
mation on how to solve them.
1 Note

Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Service
Marketplace at http://service.sap.com/notes /.

SAP Solution Manager Update

To prepare and perform the update of your SAP system, make sure that you use the latest available SAP Solution
Manager version. For an update to this SAP Solution Manager version, refer to the Master Guide — SAP Solution
Manager <release>. After you have performed the upgrade, follow the steps described in the SAP Solution
Manager <release> Configuration Guide.

Both guides are available on SAP Service Marketplace, at http://service.sap.com/instguides#|p SAP

Components » SAP Solution Manager Release <release> 1.

3.3 Preparing SAP Solution Manager

3.3.1 Preparing SAP Solution Manager

To set up your SAP Solution Manager application, perform the following steps:

1. Maintain system data in the SAP System Landscape Directory (SLD).
2. Transfer system data from SLD to the SAP Solution Manager.

3. Complete system descriptions in SAP Solution Manager System Landscape (SMSY) or Landscape
Management Database (LMDB).

4. Check the landscape data with the landscape verification function.

5. Create a maintenance transaction in the SAP Solution Manager Maintenance Optimizer to calculate support
packages and packages for product instances.

These steps are described in the Maintenance Planning Guide, which is available at http://support.sap.com/
mopz e (section Guides).
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See the SAP Community Network (SCN) for more information about

e System Landscape Directory at http://scn.sap.com/docs/DOC-8042#ar
e Landscape Verification at http://scn.sap.com/docs/DOC-8793#%

SAP Solution Manager Maintenance Optimizer (MOPZ)

The SAP Solution Manager Maintenance Optimizer plays a central role in the upgrade process. It is mandatory to

use the Maintenance Optimizer for the calculation of the required upgrade packages, enhancement packages and
Support Package stacks and for the creation of the stack configuration file (xml file). The upgrade program reads

this stack configuration file and uses it as an input file for the upgrade.

The following sections explain how to prepare SAP Solution Manager and the Maintenance Optimizer:

e SAP Solution Manager Update [page 42]

e |nstallation of Landscape Verification 1.0 for SAP Solution Manager [page 43] (required for SAP Solution
Manager releases 7.0 to 7.1 SP04)

e Configuration of the Maintenance Optimizer [page 43]
e Maintaining System Landscape Information [page 44]

3.3.2 SAP Solution Manager Update

We recommend that you use the latest available Solution Manager version, or that you always update your SAP
Solution Manager to the latest Support Package stack.

Make sure that you run the guided procedure SOLMAN SETUP after every installation or update of SAP Solution
Manager and that it completes successfully.

Table 17: Checking SAP Solution Manager Prerequisites

Step Description Documentation

1. Make sure that your SAP Solution Manager system has e See SAP Note 608277 #% for information about SAP Sol-

the required support package level and content. ution Manager Content add-ons.
2. Checkif you need to do an update or upgrade of your o See SAP Note 781448 for information about Support
SAP Solution Manager application or content. Package levels of SAP Solution Manager installations and
3. After an upgrade or update to the latest SAP Solution upgrades.

Manager release, you need to perform follow-up actions e The Solution Operations Guide for SAP Solution Manager
described in the section Software Change Management of

] ] ) is available at:http://service.sap.com/instguidesfbl}
the Solution Operations Guide

SAP Components > SAP Solution Manager >

<Release> } Operations ]
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Table 18: Information about SAP Solution Manager Update or Upgrade

Related Documents

Upgrade Guide SAP Solution Manager <Release>

Describes the update or upgrade to this release. You can in-
clude the installation of the required Support Package stack in
the update procedure.

Available at...

http://service.sap.com/instguides&-l} SAP Components >
SAP Solution Manager # <Release> » Upgrade 4-

Solution Operations Guide — SAP Solution Manager <Release>
—> section Software Change Management.

Describes the actions required after the SAP Solution Man-
ager upgrade or update.

http://service.sap.com/instguides&l) SAP Components >
SAP Solution Manager > <Release> > Operations }

3.3.3 Installation of Landscape Verification 1.0 for SAP

Solution Manager

Landscape verification is required to enable the Maintenance Optimizer to create a proper stack configuration

XML file for the correct product constellation.

For the SAP Solution Manager releases 7.0 to 7.1 SPO4, you install the Landscape Verification 1.0 as an add-on.

See SAP Note 1468605#% for information about the installation.

As of SAP Solution Manager 7.1 SP0O5, the verification function is integrated in the Landscape Management
Database (LMDB) of SAP Solution Manager. You can run the verification directly from the product system editor

to check the consistency of your system descriptions.

3.3.4 Configuration of the Maintenance Optimizer

If you have not already done so, configure the Maintenance Optimizer. For a list of configuration tasks, see the

Maintenance Optimizer configuration guide.

Table 19:

Related Documents

Available at...

Maintenance Optimizer Configuration Guide

http://support.sap.com/mopz i

(section Guides)
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3.3.5 Maintaining System Landscape Information

Use

The Maintenance Optimizer relies on up-to-date information about your system landscape. Therefore, it is crucial
that this data is correctly maintained in the SAP Solution Manager System Landscape (transaction SMSY) or
Landscape Management Database (LMDB). If you have already maintained the system landscape data, check
carefully if this data is correct.

Proceed in the following order:

1. If you have not already done so, capture the system data using the System Landscape Directory (SLD).
2. Maintain the system data in SAP Solution Manager.
3. Runthe landscape verification to check the system landscape data.

Procedure

Capturing System Data Using SLD

1. Register all systems that you want to update in your SLD. In case of a dual-stack system, you have to register
both the ABAP stack and the Java stack.
Depending on your applications, it can either be the SLD of your SAP Solution Manager system (if there are no
dependencies of production runtime systems), or you have to separate SLD systems for production and non-
production use (default recommendation).
If you use a central runtime SLD, distribute the data of all technical systems that are registered in the central
SLD, from the central SLD to the development SLDs and to the local SLD in SAP Solution Manager.
For more information about the SLD topology options and synchronization, see the Planning Guide — System
Landscape Directory available at http://scn.sap.com/docs/DOC-8042
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To register Java systems, you use the Visual Administrator, or, as of SAP NetWeaver 7.1, the NetWeaver
Administrator. To register the ABAP system, you use transaction RZ70. For more information about the
registration of systems, see the SAP Library for your source release:

Table 20:

Release

SAP NetWeaver 7.0 and SAP NetWeaver 7.0 including EHP
1and SAP NetWeaver 7.0 including EHP 2

’ SAP Library Paths

http://help.sap.com/nw70&|} Application Help >
Function-Oriented View % SAP NetWeaver by Key
Capability > Solution Lifecycle Management by Key
Capability > Software Life Cycle Management > System
Landscape Directory > Configuring Systems to Connect to

stb 3

i Note

Instead of the alias /nw70, you can use the aliases /

nw701 or /nw702 accordingly.

SAP NetWeaver 7.3, SAP enhancement package 1 for Net-
Weaver 7.3

http://help.sap.com/nw73&|} Application Help >
Function-Oriented View # Solution Lifecycle Management
> Configuring, Working with and Administering System
Landscape Directory > System Landscape Directory >
Connecting Systems to the SLD ]

1 Note

Instead of the alias /nw73, you can use the alias /
nw731 accordingly.

SAP NetWeaver Process Integration 7.1 including EHP1

http://help.sap.com/nwpi7ll?‘hr|} Application Help >
Function-Oriented View > Application Server Infrastructure
> Configuring, Working with and Administering System
Landscape Directory > Configuring Systems to Connect to

the SLD J

SAP NetWeaver Process Integration 7.1

http://help.sap.com/nwpi7ll‘h-|} System Administration
and Maintenance Information # Technical Operations for
SAP NetWeaver > General Administration Tasks >
Software Life-Cycle Management > Configuring, Working
with and Administering System Landscape Directory >

Configuring Systems to Connect to the SLD }
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Release ’ SAP Library Paths
SAP NetWeaver Composition Environment 7.1 and SAP Connecting the system to the SLD is part of the initial sys-
NetWeaver Composition Environment 7.1 EHP1 tem configuration as described at:

http://help.sap.com/nwce71#|p Application Help
Administrator's Guide > Configuration of SAP NetWeaver
CE ¥ Initial System Configuration #» Configuring System
Landscape Directory }

1 Note

Instead of the alias /nwce71, you can use the alias /

nwce711 accordingly.

SAP NetWeaver Composition Environment 7.2 Connecting the system to the SLD is part of the initial sys-

tem configuration as described at:

http://help.sap.com/nwce72l‘hr|} Application Help >

Administrator's Guide > Configuration of SAP NetWeaver
CE > Configuring Mandatory Components > Configuring
Application Server Java » Mandatory Configuration Tasks

> Configuring System Landscape Directory ]

If the registration was successful, both the ABAP system and the Java system appear in the SLD under
Technical Systems.

2. Transfer the data from the SLD to the SAP Solution Manager:

o

46

For SAP Solution Manager 7.0, schedule SLD update jobs in the SAP Solution Manager transaction
SMSY SETUP.
For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager70

#i= |l SAP Solution Manager 7.0 EHP1 SP26 » SAP Library » Basic Settings ¥ Solution Manager System
Landscape S et-Up Automatic Data Capture for System Landscape 3.

For SAP Solution Manager 7.1, setup the SLD connection under |+ SAP Solution Manager Configuration
(transaction SOLMAN_SETUP) » System Preparation » Prepare Landscape Description j» Select SLD

and Set Up LMDB 1.
For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager?1

#= | Application Help » SAP Solution Manager 7.1 SP<version> » SAP Solution Manager Operations
Landscape Management Database (LMDB): » Managing System Landscape Information » Set Up the
Landscape Management Infrastructure » Connect LMDB to System Landscape Directory (SLD) 1.
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Figure 4: Synchronization of central SLD with local SLD in SAP Solution Manager
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Figure 5: Direct synchronization of central SLD with landscape data storage in SAP Solution Manager (standard as of SAP
Solution Manager 7.1)

1 Note
For more information about the synchronization of central SLD, see

e SLD Planning Guide at http://scn.sap.com/docs/DOC-14151#

e |nformation in the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#
|+ Application Help » SAP Library SAP Solution Manager 7.1 SPO5 (or higher) » SAP Solution Manager
Operations » Landscape Management Database (LMDB): » Managing System Landscape Information 3.

Running the Landscape Verification 1.0 in SAP Solution Manager 7.0 to 7.1 SP04

Running the landscape verification 1.0 in SAP Solution Manager 7.0 to 7.1 SPO4 is an optional step. This tool
checks how your systems are maintained in the SAP Solution Manager system. If it detects any inconsistencies,
you are prompted to correct existing entries or enter missing data. The tool provides you with information about
maintaining the data.

To start the landscape verification, call transaction LvsMin SAP Solution Manager.

For more information about the landscape verification, choose the Help link from within the application, and the
documentation of landscape verification at http://scn.sap.com/docs/DOC-8793 .
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Running the Landscape Verification as of SAP Solution Manager 7.1 SPO5

Figure 6: Landscape Verification 1.0

Landscape Verification Tool Help
- System Landscape i Errors
Product Systems (grouped) [Pf] %] Technical Systems with Product Version SAP ECC 6.0
* i@ AlSystems View |[Standard View] ~| [ [Print Version |[ Export to Excel Fiter Seftings.
* i@ Unassigned Technical Systems In pe 1
Status. Name T D8 Host Assigned Product S; £}
b i@ o Active Product Versions e Pattem Ll
ra - ] AlL Java pwdf2050
¥ 1@ ACCPAYABLE WORKB. (BZAPS) 2.1 & MED ABAP vmizi19 MEQ(SAPECC £.0)
» i@ ACROBAT COM LEARN BY ADOBE 7.0 ) oot Dual Stack GL1(SAPECCED)
b i@ BOBJ ENTERPRISE X1 3.1 O QEN ABAP usdbgBn QBN(SAPECC 6.0, SAP CRM 7.0, SAP ERP £.0)
b @i MSISE0 @ QB2 ABAP QB2_TEST(SAPECC 8.0)
P MSESTO @ SA1 ABAP SA1(SAPECCED)
13 i MSFT MET 1.1 iy TES Lgar TEST12(SAPECC E.0)
b i@ MSFT .NET 2.0 @ TST Dual Stack TST(SAP NETWEAVER 7.0)
P i@ SAPEW 3.1 CONTENT
» @ SAP CONVERGENT CHARGHG 1.0
i@ SAP CONVERGENT CHARGING 2.0 AIL Froduct Instances AIL Related Erors (2 }
L3 SAP CRM 2007
@ Errors
b @i S4PCRM 40
» @i SAPCRUSO View|Standard View] __[=] [ Print Version |[ Export to Excei | Fiter Settngs
b @i SAPCRM 70 Status. Category Object Message =
» @ SAPCRM7.0/MWT.01 -] Technical System AfL Yo active prodyct version is assigned to product 01200314890800000134 on the svstem A1l
» @i SAPECCS0 [~ } Technical System AlL Ho active product version is assigned 1o produc 4590800000134 on the svstem A1L
» @i SAPECC 6.0 @ Technical System AlL lio active product version i assigned o pro 90600000134 on the system &1L
» @i SAPEHP! FOR SAP NETWEAVER 7.0 il Technical System AlL Software component KM-KW JIKS not covered by configured product instances
» £\, SAPEHP!FOR SAP NW ABAP7.1 Fiy Technical System AlL Software LM-TOOLS not coversd by configured product ingtance:
» 1@ SAPEHP1 FOR SAP NW CE 7.1 [ Technical System AL ofware componan| not covered by configured product instances
b @i SAPEHP1 FOR SAP NW JAVAT.1 5 O Technical System AlL Software componen COR not covered by configured product instances
- & Technical System AlL Software component SAP-SCHWCL not covered by conficured oroduct instances

As of SAP Solution Manager 7.1 SP0O5, the landscape verification function is integrated in the product system
editor of the Landscape Management Database (LMDB). You do not have to install an add-on any longer.

To start the landscape verification, start transaction LMDB, select a product system in edit mode and choose the

Verification step in the navigation tree.

For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#&
| Application Help  SAP Library SAP Solution Manager 7.1 SPO5 (or higher) # SAP Solution Manager Operations

» Landscape Management Database (LMDB): » Managing System Landscape Information » Manage Logical

Landscape Information }» Execute Verification Checks J.
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Figure 7: Landscape verification in the product system editor of the LMDB

Maintaining System Data

When your product systems are known in SAP Solution Manager, you have to check and maintain the system
data, and add your system to a logical component and to a solution.

To manage logical components in SAP Solution Manager 7.0 to 7.1 SPO8, you proceed as follows:

In transaction sMsY, choose System Groups and Logical Components.

2. Tocreate alogical component, choose Create New Logical Component in the context menu of Logical
Components. Enter your system data. The name of your logical component must start with “Z...".

3. Assign the related technical systems to the logical component.

4. Inthe Current System Assignments of the newly created logical component, add your systems with the
appropriate roles (such as Development System or Production System).

For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager71#|p
Application Help » SAP Library SAP Solution Manager 7.1 SPO5 (or higher) » SAP Solution Manager Operations »
Landscape Management Database (LMDB) » Managing System Landscape Information » Manage Logical

Landscape Information  Edit Logical Components 3.
To manage logical components as of SAP Solution Manager 7.1 SP09, you proceed as follows:

1. Tocreate and edit logical components, choose [ SAP Solution Manager: Work Centers ¥ Solution Manager

Administration » Landscape ¥ Logical Components .
2. Assign the related technical systems and the appropriate roles (such as Development System or Production
System) to the logical component. You have the following options:

1. Under | SAP Solution Manager Configuration » Managed Systems Configuration 3, you have to assign
logical components to the technical systems registered in the LMDB. Select a technical system and
choose Configure System. Log messages tell you whether information is missing or inconsistent. These
checks prepare a technical system so that it can be used for Early Watch Alerts, for example.
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2. You can also start transaction LMDB and select a technical system from the Technical Systems tab. In the
navigation tree, choose Software and Assign to Logical Component. For more information, see the
documentation on the Ul

For more information, see the SAP Solution Manager Library http://help.sap.com/solutionmanager71#
|\ Application Help » SAP Library SAP Solution Manager 7.1 SPO9 (or higher) » SAP Solution Manager Operations
» Landscape Management Database (LMDB) » Managing System Landscape Information » Managing Logical

Components J.
To maintain system information in SAP Solution Manager 7.0 to 7.1 SP04, you proceed as follows:

1. Intransaction sMsY, choose | Landscape Components » Product System » <System> 1.
2. Check whether the product version is correct. The product version is displayed in the right pane below the
name of your system.

3. Choose the Selection of Product Instances tab and check that everything that is installed in your system is
flagged as Relevant. Make sure that no instance is marked as relevant that is not installed in your system, as
this would lead to the installation of unwanted software components in your system.

1 Note

You can only select one ABAP instance as relevant. You have to flag further ABAP instances as Also
Installed in Relevant ABAP Product Instance.

For more information about selecting the instances and required settings, see SAP Note 1344564 #% and SAP
Note 1429764 ¥ .

4. Optional: Add the product system to a solution.
It is no longer mandatory to create a solution and to add your product system to a solution. However, if you
already have a solution, then add your product system to it. When you later create a maintenance transaction,
you can select this solution and thus restrict the number of product systems displayed.

1. Calltransaction SOLUTION MANAGER and create a solution, if it does not exist yet.

2. Choose Solution Landscape and Solution Landscape Maintenance.

3. Add your SAP system to the solution as follows:

Change to edit mode.

Place the cursor on a new line in the Logical Component column.

Use the input help to select your system from the list (product, logical component).
Choose Complete System Data Replication.

oN N e

Save your selection.
To maintain system information as of SAP Solution Manager 7.1 SPO5, you proceed as follows:

1. Intransaction LMDB, choose | Product Systems » <System> » Edit J.

2. Inthe navigation tree, choose Technical Systems to see which product instances of which product version of
which technical systems are assigned to the product system.

3. Check, if the product version is correct.

4. To change the assignments, choose Add or Edit Selected.

5. Werecommended that you start a verification run each time when you have changed an assignment. You can
perform this in the Verification step of the navigation tree.

For more information, see the SAP Solution Manager Library at http://help.sap.com/solutionmanager7 1
|» Application Help » SAP Library SAP Solution Manager 7.1 SPO5 » SAP Solution Manager Operations
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Landscape Management Database (LMDB) » Managing System Landscape Information » Manage Logical
Landscape Information  Create Product System Information 4.

3.4 System Copy and Migration

Use

At several stages in the lifecycle of your SAP solution, you will face the requirement to perform a system copy or a
migration. For example, SAP recommends that you perform a system copy to create test, demo and training
systems. Also, if you need to change your operating system and/or database, you have to perform a migration of
your SAP system.

For this, SAP is offering system copy and migration services that enable you to create consistent copies of your
SAP systems, flexibly adapted to your needs - be it an SAP system distributed to several hosts, a high-availability
system or a system on a rather exotic operating system/database combination.

More Information

e For anintroduction into system copy and migration, see http://scn.sap.com/docs/DOC-8324# in the SAP
Community Network.

e System copy guides are available on SAP Service Marketplace at http://service.sap.com/installnw74 .

e Alternatively, you can copy your system with a completely automated end-to-end framework available with
the SAP NetWeaver Landscape Virtualization Management <Release>, Enterprise Edition. For more
information, see the SAP Help Portal at http://help.sap.com/nwivm#e .
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4 Upgrading, Configuration, and Follow-Up
Activities

4.1 Upgrading Procedures for NetWeaver Key Areas

In the following you find an overview about the procedures with regard to the different key areas of SAP
NetWeaver. For more information about the key areas, refer to SAP NetWeaver Use Cases [page 10].

4.1.1 Upgrade of Scenarios Based on SAP Enterprise Portal

Below you will find information about upgrading scenarios that are based on SAP Enterprise Portal. This section is
relevant for you if you used one of the following scenarios:
e SAP NetWeaver 2004: SAP EP
e SAP NetWeaver 7.0:
© Running an Enterprise Portal

o Enterprise Knowledge Management: Content Integration and Management; Content Creation, Publication
and Access

o Enabling User Collaboration
o Developing, Configuring and Adapting Applications: Creating Portal Applications Using PDK for .NET

As of SAP NetWeaver 7.3, the functional scope is covered by use case Integrating and Self-Servicing Content with
SAP Enterprise Portal. The following figure shows the software units which make up the use case.
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Figure 8: Integrating and Self-Servicing Content with SAP Enterprise Portal

1 Note
SAP NetWeaver Application Server Java 7.4 SPO3 or higher based on SAP HANA

As of SAP NetWeaver 7.4 SPO3, the SAP HANA database supports Application Server Java and further product
instances that are dependent on AS Java. For more information in terms of the implementation of SAP
NetWeaver Application Server Java 7.4 based on SAP HANA database, see the End-to-End Implementation
Roadmap for SAP NetWeaver AS Java based on SAP HANA.

This guide is available on the Service Marketplace at http://service.sap.com/upgradenw74#%|» Planning .

4111 Upgrade Sequence

The following table describes the sequence in which you have to perform the upgrade or installation steps.

SAP NetWeaver Upgrade Master Guide
54 PUBLIC Upgrading, Configuration, and Follow-Up Activities


http://help.sap.com/disclaimer?site=http://service.sap.com/upgradenw74

1 Note
For information about finding the referenced documentation, see section Documentation References [page

82].

Table 21:

Action Remarks / Subsequent Steps

[Required Documentation]

1 You upgrade SAP NetWeaver Portal 6.0 or SAP Net- As SAP NetWeaver 7.4 is only supported with Support
Weaver 7.0 Enterprise Portal. Package Stack (SPS) 02 or higher, include at least SPS
02 into the upgrade. However, we highly recommend

[Update Guide — Update of SAP Systems Using Soft- ) )
that you always install the latest available Support

ware Update Manager <version>] Back tack
ackage stack.

[Upgrade and Update Guide - SAP NetWeaver 7.4

JAVA] If you install SAP NetWeaver 7.4 with Support Release

2, you install automatically the previously available
support packages 1to 8 at once, and your system goes
immediately to 7.4 SP8 without needing to implement
the intervening SPs separately.

SAP NetWeaver 7.4 with Support Release 1 includes
the support packages 1to 5. If you perform an update
with target release NW 7.4 SR1, your system goes im-
mediately to 7.4 SP5.

2 You upgrade the Portal Development Kit.

[Installation, Upgrade, and Configuration Guide — PDK
for .NET]

3 If installed as a separate system: you upgrade the sys-
tem with product instances AS Java and DI.

[Update Guide — Update of SAP Systems Using Soft-
ware Update Manager <version>]

[Upgrade and Update Guide - SAP NetWeaver 7.4
JAVA]
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Action Remarks / Subsequent Steps

[Required Documentation]

4 You upgrade the standalone RTC application server.

If you upgrade a standalone RTC application sharing
server that is running on product instance AS Java, and
which does not have product instance EPC installed,
then the system contains the product instances EP
Core — Application Portal and EP after the upgrade.
The required software is calculated by the SAP Solu-
tion Manager Maintenance Optimizer and installed dur-
ing the upgrade.

[Update Guide — Update of SAP Systems Using Soft-
ware Update Manager <version>]

[Upgrade and Update Guide - SAP NetWeaver 7.4
JAVA]

5 You upgrade the Forums Application.

[SAP Note 1049553 /]

6 You upgrade SAP NetWeaver Search and Classification
(TREX).

[Upgrade Guide — TREX 6.1 to SAP NetWeaver 7.0 TREX
(TREX 7.0)

[Upgrade Guide — TREX 7.0 to SAP NetWeaver 7.1 TREX
(TREX 7.1)]

7 Perform the delta configuration [page 80].

4.1.2 Upgrade of Scenarios Based on SAP Business Warehouse

Below you will find information about upgrading scenarios that are based on SAP Business Warehouse. This
section is relevant for you, if you used one of the following scenarios:

e SAP NetWeaver 2004: SAP Business Information Warehouse; Bl Information Broadcasting

e SAP NetWeaver 7.0: Business Planning and Analytical Services; Enterprise Reporting, Query, and Analysis;
Enterprise Data Warehousing

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Data Warehousing. The following figure
shows the software units that make up the use case.

SAP NetWeaver Upgrade Master Guide
56 PUBLIC Upgrading, Configuration, and Follow-Up Activities


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1049553

Clients

SAP GUI
incl.

ELy Business Design

Modeling

Web

Intelli- Crystal Dash-

Reports boards

Analysis

Explorer Browser Studio ance
(Bl Add- g
On)

Tools

1 1 1
Systems with Product Instances Standalone
Engines
Bl Java

Search and SAP Business Objects
Classification Business Intelligence
(TREX) Platform

AS ABAP

Figure 9: Data Warehousing

1 Note

SAP Strategic Enterprise Management

If you have the SEM-BW add-on installed in your source release, read the following information in the SAP
Community Network:

1. http://scn.sap.com/docs/DOC-30452

2. http://scn.sap.com/community/data-warehousing/bw/blog/2013/11/13/good-news--easier-modeling-
of-the-sem-add-on-in-solution-manager #r

412.1 Data Warehousing on top of SAP HANA database

With SAP Business Warehouse (SAP BW) powered by SAP HANA database, SAP offers the SAP HANA database
being the in-memory deployment option for the Data Warehousing use case. In combination with SAP BW 7.40
SPSO8 (or higher) it is necessary to use SAP HANA SPOS8 or higher. Revision 82 is the minimum revision for SAP
HANA SP08. We recommend to always use the latest available SAP HANA SPO8 revision.

For more information on implementation conditions, scenario limitations and implementation sequence, see the
End-to-End Implementation Roadmap for SAP BW, powered by SAP HANA on http://service.sap.com/installnw74

| Planning 3 and see SAP Note 1600929#% as well as SAP Note 1949273 .
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4122 Upgrade Sequence

Use

The following table describes the sequence in which you have to perform the upgrade or installation steps.

1 Note

e Forinformation about finding the referenced documentation, see section List of Documentation. [page
82] Consider also the composite notes for BW 7.30 Upgrade: 1636053#% (Upgrade SAP NetWeaver 7.30:
BW-Server) and 1636057 (Upgrade SAP NetWeaver 7.30: Bl Java).

e Foranoverview about the steps needed for migrating an existing SAP BW installation to the SAP HANA
database, refer to the End-to-End Implementation Roadmap for SAP BW, powered by SAP HANA available

at http://service.sap.com/instalinw74#|p Planning .

Procedure

Table 22:

Action Remarks and Subsequent Steps

[Corresponding Documentation] [Corresponding Documentation]

SAP BW on the SAP HANA database: .
Caution

® |ncase you want to deploy SAP BW on SAP
HANA database, and you have ABAP+Java dual
stack systems in your source release: Separate
the ABAP stack from the Java stack.

For more information, see sectionDual-Stack
Split [page 25].

e |fyou want to upgrade from SAPBW 7.3 0or 7.3
EhP1 running on SAP HANA, to SAP BW 7.4
running on SAP HANA: Update SAP HANA da-
tabase to SPS 08, revision 82 or higher before
you upgrade SAP BW (ABAP).

e See SAP Note 1600929 for more informa-
tion.

SAP NetWeaver Upgrade Master Guide
58 PUBLIC Upgrading, Configuration, and Follow-Up Activities


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1636053
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1636057
http://help.sap.com/disclaimer?site=http://service.sap.com/installnw74
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1600929

Action Remarks and Subsequent Steps

[Corresponding Documentation] [Corresponding Documentation]

1 You upgrade the SAP BW ABAP server. ® Therequired Basis plug-in (PI_Basis) is included in

) the upgrade. It includes the Enterprise Portal plug-
[Upgrade and Update Guide - SAP NetWeaver 7.4

ABAP] "
e You must update the BI_CONT add-on to
SAP Note 1943931 BI_CONT 747 SPO5 or BI_CONT 757 during the
upgrade of the SAP BW server. The upgrade proc-
1 Note ess prompts you for the required DVD at the ap-

propriate point in time. For more information, see
SAP Notes 1808103#% and 1853775 .
Alternatively, there is SAP Netweaver 7.4 Bl Con-
tent 7.57 or SAP Netweaver 7.4 Bl Content Exten-
sions Add-On 7.57 available for SAP NetWeaver
7.4 SPS 05 and higher. This version of Bl Content
Add-On will be used for providing additional data
flows that make use of the new BW features deliv-
ered only from SAP NetWeaver 7.4 SPS 05 and
higher. If you use the already existing Bl Content
Add-on 7.47 then the limitation is that you would
not receive the data flows based on Netweaver 7.4
SPSO05 (and higher) features; it also means that
the already existing Bl Content Add-on 7.47 would
not support the new BW features valid only for
SAP Netweaver 7.4 SPS 05 and higher. Consider-
ing the above limitation we recommend that you
upgrade to Bl Content Add-on 7.57.

e Check also the SAP Note 153967 regarding the
Bl Content Release Strategy, and SAP Note

1000822 "% for an overview about the notes for
the add-ons BI_CONT and BI_CONT_XT.

If you have a dual-stack system, both the ABAP and
the Java upgrade run in parallel in an integrated
procedure.

1 Note

Since SAP NetWeaver 7.4 is only supported with
Support Package Stack (SPS) 02 or higher, include
at least SPS 02 into the upgrade. However, we
highly recommend that you always install the latest
available Support Package stack.

If you install SAP NetWeaver 7.4 with Support Re-
lease 2, you install automatically the previously
available support packages 1 to 8 at once, and your
system goes immediately to 7.4 SP8 without need-
ing to implement the intervening SPs separately.
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Action

[Corresponding Documentation]

Remarks and Subsequent Steps

[Corresponding Documentation]

SAP NetWeaver 7.4 with Support Release 1 includes
the support packages 1to 5. If you perform an up-
date with target release NW 7.4 SR1, your system
goes immediately to 7.4 SP5.
Note for SAP BW on SAP HANA database:
In addition to the SAP NetWeaver Support Package
Stack, we recommend to apply the SAP Notes men-
tioned in SAP Note 1949273 % for the respective
Support Package Stack.
2 You upgrade your Java systems. e Since SAP NetWeaver 7.4 is only supported with
] Support Package Stack (SPS) 02 or higher, in-
[Upgrade and Update Guide - SAP NetWeaver 7.4 clude at least SPS 02 into the upgrade.
JAVA]
If no AS Java based installation exists, but youwantto | ® The installation of product instance Bl Java in-
use Bl Java based functions, install an SAP NetWeaver cludes the installation of product instance EP
7.4 system with product instance Bl Java. Core— Application Portal and EP, since Bl Java de-
pends on these product instances.
[Installation Guide — SAP NetWeaver Application
Server Java]

3 Optional: You upgrade SAP NetWeaver Search and TREX enables fast and complex search for Bl meta-
Classification (TREX). data. The metadata is directly indexed with its attrib-
[[Upgrade from TREX 6.1 to SAP NetWeaver TREX 7.0] utes Aand itis available in Fhe search. Therefore, search

queries such as "All queries that contain the character-

[Upgrade Guide — SAP NetWeaver TREX 7.0 to TREX istic 'customer' and the key figure 'sales' " are sup-

7.1]. ported. To be able to use all functions of the search (for
example, the search query described above), you have
to use TREX. However, as a base function, you can
search for objects using their text and technical name
also without TREX. For more information, see SAP
Note 979444 ¥ .
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Action

[Corresponding Documentation]

Optional: You upgrade the SAP R/3 back-end plug-in
to at least version 2004.1.

Documentation: Composite SAP Note 704564 #% : R/3
plug-in: Pl 2004.1 installation/delta upgrade

1 Note

e New and extended interfaces for integrating
SAP R/3, SAP R/3 Enterprise, and SAP ERP
Central Component (SAP ECC) will no longer
be delivered with their own add-on (SAP R/3
Plug-In). As of SAP ECC 6.0, they will be con-
tained directly in SAP ECC. Therefore, this step
is not required for SAP ECC 6.0 or higher.

For more information about the delivery strat-
egy, see SAP Service Marketplace at https://
service.sap.com/r3-plug-inf.

e With Bl-Java, you get access to non-SAP data
sources by using the corresponding JDBC
driver.

Remarks and Subsequent Steps

[Corresponding Documentation]

You upgrade the SAP GUI for Windows including the BI
add-on (Business Explorer) on each host for which you
want to create a connection to the SAP NetWeaver 7.4
BW server.

[Installation Guide — SAP Front End]

Up to SAP enhancement package 2 for SAP NetWeaver
7.0 you could maintain query properties using transac-
tion RSRT. As of SAP NetWeaver 7.3, the maintenance
of query properties has been partially moved into the
BEx Query Designer. The settings Data Integrity and
Read Near-Line Storage As Well are now available in
BEx Query Designer (in the Query Properties) and you
can no longer maintain them in RSRT.

You install the Modeling Tools for SAP BW powered by
SAP HANA to use the Eclipse-based BW modeling en-
vironment.

See the installation guide at: http://service.sap.com/

nstallnw74l‘hr|} Installation > Installation — Clients ]

Perform the delta configuration [page 80].

4.1.3 Upgrade of Scenarios Based on SAP Process Integration

Caution

As of release SAP NetWeaver 7.4, we strongly recommend to avoid optional dual-stack deployments where
possible. By way of exception, dual-stack implementations can still exist in former is SAP Process Integration
installations.
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In general, SAP Pl dual-stack will be supported in SAP NetWeaver 7.4. However, you are recommended to
migrate SAP Pl content into SAP NetWeaver Pl Java single stack (Advanced Adapter Engine Extended). This
approach should be feasible for most use cases. Due to the harmonized process orchestration stack (SAP Pl
and SAP BPM running on the same Java instance), stateful system-centric processes can be developed using
SAP Process Orchestration capabilities. Processes that are created with ccBPM need to be redesigned and
modeled with SAP BPM. For more information about how to do this, see the SAP Community Network SCN at
http://scn.sap.com/docs/DOC-28803 .

Below you will find information about upgrading scenarios that are based on SAP Process Integration. This section
is relevant for you if you use one of the following scenarios:

SAP NetWeaver 7.0: Enabling Application-to-Application Processes; Enabling Business-to-Business
Processes, Enabling Enterprise Services

SAP NetWeaver Process Integration 7.1/ 7.1 including enhancement package 1: SOA-Based Integration
Note that the use case SOA-Based Integration has been renamed as Building Integration Scenarios.

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Building Integration Scenarios. The
following figures depict the three options with the software units, which make up the use:

e Pl standard installation
e Advanced Adapter Engine Extended (AEX) installation
® Process Orchestration
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g Q Q Q Q
=
g
c : - i
2 Enterprise Services | Integratiph Server i
m . 1 = i
Eg Repository Business
> E | Process i
o<—O- % | ES Builder ‘ Engine
- i | Non-Central
@ & v ] i Advanced
vance . !
& - i E apter Engine*® : Engine
ur) = | |
= s Ot . ngine !
v = . i ! . h
g c Integration ( Runtime Cache ) Rurtime Cache | | Runtime Cache
= = Directory | | L0 y e—— | —— Fo—— !
R» EU | |
o< O—%¢ | Integration Builder |
% Replicate Replicate Replicate
5 ( ) configuration configuration configuration
-E ( Configuration Content >
&
E
Q
o
AS Java AS ABAP
Process Integration Instance {Dual-Stack)
Figure 10: System Landscape for Building Integration Scenarios with Pl Standard Installation
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The standard installation offers the complete functional range, whereas the functional range of AEX is restricted,

but has the advantage of a lower TCO.
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Figure 12: System Landscape for Building Integration Scenarios with Process Orchestration

The Process Orchestration provides a tool infrastructure to model and design business processes — from the
overall process flow and the sequence of activities up to the interfaces and data types that are needed to integrate
SAP systems and external systems. It combines the integration capabilities of SAP Process Integration Advanced
Adapter Engine Extended (AEX) with the process modeling, operation, and monitoring capabilities of SAP
Business Process Management (BPM). Like AEX, the Process Orchestration is based on AS Java only.

1 Note

SAP NetWeaver Application Server Java 7.4 SPO3 or higher based on SAP HANA

As of SAP NetWeaver 7.4 SP0O3, the SAP HANA database supports Application Server Java and further product
instances that are dependent on AS Java. For more information in terms of the implementation of SAP
NetWeaver Application Server Java 7.4 based on SAP HANA database, see the End-to-End Implementation
Roadmap for SAP NetWeaver AS Java based on SAP HANA.

This guide is available on the Service Marketplace at http://service.sap.com/upgradenw74#% | Planning 3.
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41.3.1 Upgrade Sequence

The following table describes the sequence in which you have to perform the upgrade or installation steps.

1 Note

For information about finding the referenced documentation, see section List of Documentation.
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Table 23:

Action Remarks / Subsequent Steps

[Required Documentation]

1 You upgrade the SAP NetWeaver system with product | ® As SAP NetWeaver 7.4 is only supported with
instance PI. Support Package Stack (SPS) 02 or higher, in-
clude at least SPS 02 into the upgrade. However,
we highly recommend that you always install the
latest available Support Package stack.

[Update Guide — Update of SAP Systems Using the Soft-
ware Update Manager 1.0]

[Upgrade and Update Guide - SAP NetWeaver 7.4 <tech-
nology>] 1 Note

If you install SAP NetWeaver 7.4 with Support Re-
lease 2, you install automatically the previously
available support packages 1to 8 at once, and your
system goes immediately to 7.4 SP8 without need-
ing to implement the intervening SPs separately.

SAP NetWeaver 7.4 with Support Release 1includes
the support packages 1to 5. If you perform an up-
date with target release NW 7.4 SR1, your system
goes immediately to 7.4 SP5.

e Forupgrades from SAP NetWeaver 7.0 (including
enhancement packages), or SAP NetWeaver 7.3,
or SAP EHP1 for NetWeaver 7.3, or SAP NetWea-
ver PI 7.1 (including enhancement package 1), or
SAP NetWeaver 7.4, you use the Software Update
Manager (SUM).

e [fyou use partner adapters, see SAP Note
1522700#% for information about their release re-
strictions.

e Modules or adapters that you have developed for
SAP NetWeaver 7.0 adapter framework, do not
runin the Process Integration framework of SAP
NetWeaver 7.4 PI. During the upgrade of the
adapter framework, you have to replace them by
appropriate versions for the SAP NetWeaver 7.4
Pl adapter framework.

If you cannot upgrade these modules or adapters,
you may use a J2EE Adapter Engine of SAP Net-
Weaver 7.0 as a non-central Adapter Engine in
your SAP NetWeaver 7.4 landscape. To do so, you
have to move all scenarios containing these mod-
ules and adapters to a non-central Adapter Engine
of SAP NetWeaver 7.0 before you upgrade the
central Pl system.
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Action

[Required Documentation]

Remarks / Subsequent Steps

2 You upgrade the standalone Adapter Engine.

[Update Guide — Update of SAP Systems Using the Soft-
ware Update Manager <version>]

[Upgrade and Update Guide - SAP NetWeaver 7.4 Java]

As this is an AS Java based system, the standard up-
grade procedure and tools for SAP Java systems are
used.

3 You upgrade the Adapter Engine (Java SE).

SAP NetWeaver 7.4 Library at http://help.sap.com/
nw74#% |l Application Help  Function-Oriented View
> Process Integration > Adapter-Engine (Java SE) >
Installation 3

The Adapter Engine (Java SE), including the contained
adapters, is only supported for compatibility reasons.
Itis not developed any further. It should therefore only
be used in cases where it is unavoidable.

4 You upgrade Search and Classification (TREX).

[Upgrade Guide — SAP NetWeaver TREX 7.0 to TREX
7.1].

5 You upgrade your SAP GUI installations.

[Installation Guide — SAP Front End]

6 If required, transfer Enterprise Service Repository
(ESR) content from SAP NetWeaver CE 7.1 ESR to SAP
NetWeaver 7.4 PI ESR.

[Upgrade of System Landscapes Including ES Reposi-
tory for SAP CE [page 68]]

7 You perform the delta configuration [page 80].

The following table shows the procedure depending on the source release and technology of a Pl Dual-Stack

system:
Table 24:
Source Release Technology Procedure
7.00,7.01,7.02 Java upgrade
ABAP enhancement package installation
7.10,7.11,7.30 Java enhancement package installation
ABAP upgrade
7.31 Java enhancement package installation
ABAP enhancement package installation
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41.3.2 Upgrade of System Landscapes Including ES
Repository for SAP CE

Use

If your source release system landscape contains an Enterprise Service Repository (ESR) of SAP NetWeaver
Composition Environment 7.1, you should discontinue using this ESR. Instead, use the ESR included in SAP
NetWeaver 7.4 Process Integration. Proceed as outlined below.

Process

Upgrade to SAP NetWeaver 7.4 Process Integration.
2. Transport the ESR content from SAP Composition Environment to SAP Process Integration either using the
Change Management Server (CMS) of SAP NetWeaver DI, or using the file system. For more information, see

the SAP NetWeaver 7.4 Library at http://help.sap.com/nw74#%& | Application Help » Function-Oriented
View » Process Integration » Enterprise Services Repository & Registry » Managing Services in the
Enterprise Services Repository » Transporting Objects » Transporting ESR Content and Objects of

Integration Directory 3
3. You manually have to assign users to the user groups of the SAP Pl ESR since these cannot be transferred
from the SAP CE ESR.

4.1.4 Upgrade of Scenarios Based on SAP Composition
Environment

Below you will find information about upgrading scenarios that are based on SAP Composition Environment. This
section is relevant for you if you use SAP NetWeaver Composition Environment 7.1, 7.1 including enhancement
package lor7.2.

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Building Composite Applications. The
following figure shows which software units make up the use case.
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Figure 13: Building Composite Applications

1 Note
SAP NetWeaver Application Server Java 7.4 SPO3 or higher based on SAP HANA

As of SAP NetWeaver 7.4 SP0O3, the SAP HANA database supports Application Server Java and further product
instances that are dependent on AS Java. For more information in terms of the implementation of SAP
NetWeaver Application Server Java 7.4 based on SAP HANA database, see the End-to-End Implementation
Roadmap for SAP NetWeaver AS Java based on SAP HANA.

This guide is available on the Service Marketplace at http://service.sap.com/upgradenw74#%|» Planning 4.

4141 Upgrade Sequence

The following table describes the sequence in which you have to perform the upgrade or installation steps.
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1 Note
For information about finding the referenced documentation, see section Documentation References [page

82].

Table 25:

Action Remarks / Subsequent Steps

[Required Documentation]

1 You upgrade the SAP Composition Environment | As SAP NetWeaver 7.4 is only supported with
server or Developer Workplace. Support Package Stack (SPS) 02 or higher, in-

[Update Guide — Update of SAP Systems with clude at least SPS 02 into the upgrade. However,

we highly recommend that you always install the
Software Update Manager 1.0] gny y Y

latest available Support Package stack.

1 Note

If you install SAP NetWeaver 7.4 with Support
Release 2, you install automatically the previ-
ously available support packages 1 to 8 at
once, and your system goes immediately to
7.4 SP8 without needing to implement the in-
tervening SPs separately.

SAP NetWeaver 7.4 with Support Release 1
includes the support packages 1to 5. If you
perform an update with target release NW 7.4
SR1, your system goes immediately to 7.4

SP5.
2 You upgrade the SAP NetWeaver Developer Stu- | Install SAP NetWeaver Developer Studio 7.3
dio. EHPI latest SP to use it as development environ-
t for SAP NetW 7.4 latest SP. S |
[Installation and Update Guide — SAP NetWeaver menttor € ':f\ver ates eeaiso
Developer Studio 7.4 ] SAP Note 1791485 .
3 Perform the delta configuration [page 80].

4.1.5 Upgrade of Scenarios Based on SAP NetWeaver Mobile

Below you will find information about upgrading scenarios that are based on SAP NetWeaver Mobile.
Depending on your source release, you either have to perform a migration or an upgrade to the target release:

e Source release SAP NetWeaver 2004 and SAP NetWeaver 7.0: Since the system landscape and software
architecture changed, you need to perform a migration. For information about the migration procedure, see
the Migration Guide — SAP NetWeaver Mobile 7.1.

e SAP NetWeaver Mobile 7.1 and SAP NetWeaver Mobile 7.1 including enhancement package 1: You can
upgrade directly to SAP NetWeaver Mobile 7.4.
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1 Note

SAP NetWeaver Mobile is available as add-on for SAP NetWeaver as of SAP enhancement package 1 for
NetWeaver 7.3. If you use SAP NetWeaver Mobile either on SAP NetWeaver 7.10 or on SAP NetWeaver 7.3,
you install the add-on on top of SAP NetWeaver 7.4.

Choose the add-on SAP NetWeaver Mobile 7.4 while selecting in the SAP Solution Manager Maintenance
Optimizer the files, which are necessary for the upgrade. The further upgrade steps are outlined below in
section Upgrade Sequence.

For more information about the installation of the add-on SAP NetWeaver Mobile 7.4, see SAP Note
1645275 .

As of SAP NetWeaver 7.3, the functional scope is covered by the use case Mobilizing Business Processes. The
following figure shows the software units that make up the use case.

Clients

Developer

Web Browser

SAP GUI Mobile Client

Studio

I
Systems with Product Instances Backend Systems

EPC -

Application

AS Java AS Java AS ABAP

Figure 14: Software Units for Mobilizing Business Processes

4151 Upgrade Sequence

The following table describes the sequence of upgrade steps for upgrading from SAP NetWeaver Mobile 7.1 and
SAP NetWeaver Mobile 7.1 including enhancement package 1to SAP NetWeaver 7.4.

Caution

As of SAP enhancement package 1 for SAP NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on.
See SAP Note 1645275 for further information about installing SAP enhancement package 1 for SAP
NetWeaver Mobile 7.3.

1 Note

For information about finding the referenced documentation, see section Documentation References [page
82].
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Table 26:

Action

[Corresponding Documentation]

Remarks and Subsequent Steps

[Corresponding Documentation]

1 You upgrade the SAP NetWeaver Mobile server. ® As SAP NetWeaver 7.4 is only supported with
Undate Guide — Undate of SAP Syst Using Soft Support Package Stack (SPS) 02 or higher, in-
[Up aUed L;I ; paateo i ystems Lsing <0 clude at least SPS 02 into the upgrade. However,
< >
ware Update Manager <version>] we highly recommend that you always install the
[Upgrade and Update Guide - SAP NetWeaver 7.4 latest available Support Package stack.
ABAP] If you install SAP NetWeaver 7.4 with Support
Release 2, you install automatically the previ-
ously available support packages 1 to 8 at once,
and your system goes immediately to 7.4 SP8
without needing to implement the intervening
SPs separately.
SAP NetWeaver 7.4 with Support Release 1in-
cludes the support packages 1to 5. If you per-
form an update with target release NW 7.4 SR1,
your system goes immediately to 7.4 SP5.
e Forthe upgrade from SAP NetWeaver Mobile 7.1
to SAP NetWeaver 7.4, make sure that SAP Net-
Weaver Mobile 7.1 includes at least SPS 04 or
higher.
2 You generate the software component versions
(SWCV).
You must regenerate all the data objects that are part
of the SAP Basis 7.10 software component version
along with other application-specific software compo-
nent versions.
3 You configure the Data Orchestration Engine (DOE).
See SAP Help Library at http://help.sap.com/nw74
|} Application Help } SAP NetWeaver Mobile >
Configuring SAP NetWeaver Mobile # Configuring
SAP NetWeaver AS > Performing DOE Initial Setup
and Configuration 3
4 If existing in your landscape, you upgrade your AS
Java-based systems with product instance DI or En-
terprise Portal.
[Upgrade and Update Guide - SAP NetWeaver 7.4
Java]
[Update Guide — Update of SAP Systems Using Soft-
ware Update Manager <version>]
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Action Remarks and Subsequent Steps

[Corresponding Documentation] [Corresponding Documentation]

5 You upgrade your mobile clients (if SAP Mobile Cli-
ents are used):

1. Download patches from SAP Service Market-
place and then upload them to the Data Orches-
tration Engine.

See SAP Help Library at http://help.sap.com/

nw74|} Application Help > SAP NetWeaver
Mobile > Administering SAP NetWeaver Mobile

» Software Logistics 4

2. Apply patches.
You assign the patches to the client devices,
which makes them available in the outbound
queues of the devices. On the next synchroniza-
tion of the client with the DOE, the patch is down-
loaded to the client device. The client installer ap-
plies the patches on the client, and then auto-
matically restarts the client.
See SAP Help Library at http://help.sap.com/

nw74 | Application Help » SAP NetWeaver
Mobile > Administering SAP NetWeaver Mobile
> Software Logistics > Applying Patches >
Applying Patches on the Mobile Client 1

6 You upgrade your SAP GUl installations.

[Installation Guide — SAP Front End ]

4.1.6 Upgrade of SAP Knowledge Warehouse

Below you will find information about upgrading SAP Knowledge Warehouse. This section is relevant for you if you
used one of the following scenarios:

e SAP NetWeaver 2004: SAP KW
e SAP NetWeaver 7.0: IT scenario Documentation, Training Materials and Manuals Management

1 Note

As of SAP NetWeaver 7.0, SAP Knowledge Warehouse (SAP KW) is an integral part of SAP NetWeaver
Application Server.

For more information, see the SAP Note 1406422 ¥ .

SAP NetWeaver Upgrade Master Guide
Upgrading, Configuration, and Follow-Up Activities PUBLIC 73


http://help.sap.com/nw74
http://help.sap.com/nw74
http://help.sap.com/disclaimer?site=http://help.sap.com/nw74
http://help.sap.com/disclaimer?site=http://help.sap.com/nw74
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1406422

The following figure shows a typical system landscape for SAP Knowledge Warehouse:
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Figure 15;: SAP Knowledge Warehouse

416.1 Upgrade Preparation

41.6.11 Upgrade Preparation

Perform the following preparations before you start the upgrade of your SAP Knowledge Warehouse system.

416.1.2 Backing Up the SAP System and the SAP Content
Server

Before you start the upgrade, create a backup of the SAP system (ABAP+Java dual-stack system) and of all SAP
Content Servers. The SAP system and the SAP Content Servers must be in a consistent state when you perform
the backup. We recommend that you create the backup after you have made the last changes to your production
data. Otherwise, data could be lost if problems occur during the upgrade.

If your Application Server Java is installed as a standalone system, you need to create a backup for this system as
well.

Make sure that you also create a backup of the MaxDB instance related to the SAP Content. The further usage of
the SAP KW content is only possible, if the latest files stored in the SAP Content Server fit to the metadata stored
in the SAP system and vice versa.

416.1.3 Saving the SAP Content Server Configuration File

Create a copy of the file contentserver.ini (on Windows) or cs. conf (on Unix). This file contains information
about the repositories stored in the MaxDB (formerly SAP DB) instance. You can find it in the home directory of
the SAP Content Server Web site. Save the copy of the file in a different directory from the original one.
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This file is especially important as it contains information about already existing content repositories in the SAP
Content Server.

416.1.4 Saving Customer-Specific Changes to the Internet
Knowledge Servlet

If you have made changes to the display component of the SAP Knowledge Warehouse, the Internet Knowledge
Servlet (IKS), for example, if you changed the graphics in the banner to meet your requirements for corporate
identity, save a version of the SCA (Software Component Archive) of the source release IKS so you can apply your
changes to the IKS-SCA of your target release.

1 Note

SAP ITS is no longer required.

416.2 Upgrade Sequence

The following table describes sequence in which you have to perform the upgrade or installation steps.

1 Note

For information about finding the referenced documentation, see section Documentation References [page
82].
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Table 27:

Action

[Corresponding Documentation]

Remarks and Subsequent Steps

[Corresponding Documentation]

1 Upgrade the Application Sever ABAP and Application As SAP NetWeaver 7.4 is only supported with Support
Server Java. Package Stack (SPS) 02 or higher, include at least SPS
02 into the rade. However, we highly recommend
[Upgrade and Update Guide - SAP NetWeaver 7.4 ABAP] I upe ) wever. w I_g Y
that you always install the latest available Support Pack-
[Upgrade and Update Guide - SAP NetWeaver 7.4 Java] | age stack.
[Update Guide — Update of SAP Systems Using Software
_ 1 Note
Update Manager <version>]
If you install SAP NetWeaver 7.4 with Support Re-
lease 2, you install automatically the previously avail-
able support packages 1to 8 at once, and your sys-
tem goes immediately to 7.4 SP8 without needing to
implement the intervening SPs separately.
SAP NetWeaver 7.4 with Support Release 1includes
the support packages 1to 5. If you perform an up-
date with target release NW 7.4 SR1, your system
goes immediately to 7.4 SP5.

2 Uninstall older versions of SAP Gateway. An SAP Gateway is only required if SAP Content Server
is installed on a different server than the AS ABAP in-
stance. Otherwise, the gateway of the existing SAP in-
stance can be used.

3 Uninstall the SAP Internet Transaction Server if it exists.

1 Note
To uninstall an ITS instance that is only used for your . .
A standalone instance of SAP ITS only exists for very
KW system, proceed as follows: o
low Support Package levels of SAP Web Application
1. Start the Microsoft Management Console. Server 6.40 (lower than SPS13). If your system has a
Close the ITS Web site. higher Support Package level or is already on SAP
3. Choose Save and close the Microsoft Management | NetWeaver release 7.0, no activity is required here.
Console.
4. Choose |l Start ¥ Settings # Control Panel ¥
Add/Remove Programs > Internet Transaction
Server 4.
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Action

[Corresponding Documentation]

Upgrade the SAP Content Server and Cache Server (if
used).

[Installation Guide SAP Content Server 6.40]

Remarks and Subsequent Steps

[Corresponding Documentation]

For SAP Knowledge Warehouse, the content has to be
stored in a MaxDB database. The upgrade of SAP Con-
tent Server may also require an upgrade of the MaxDB
instance. For information about the supported combina-
tions of SAP Content Server, operating system and
MaxDB version, see the Product Availability Matrix at

http://service.sap.com/pam .

If SAP Content Server is installed on a different server
than the SAP Web AS, you can perform the upgrade ac-
tivities in parallel.

If the Content Server configuration file has been
changed by these actions, then use the configuration
file from the preparation step to have access to the re-
positories again. Do not try to re-create them.

Install SAP Gateway, if SAP Gateway is not already in-
stalled on your system.

[Installation Guide — Standalone Gateway on <Operating
System> — For SAP Systems Based on SAP NetWeaver
7.4]

If SAP Content Server is installed on the same host as
the SAP NetWeaver Application Server ABAP, you do
not need to install the SAP Gateway.

Install or update to SAP NetWeaver Search and Classifi-
cation (TREX).

[Installation Guide — SAP NetWeaver 7.1 TREX Single
Host

Installation Guide — SAP NetWeaver 7.1 TREX Multiple
Hosts

Upgrade Guide — TREX 6.1 to SAP NetWeaver 7.0 TREX
(TREX 7.0)]

Upgrade Guide — TREX 7.0 to SAP NetWeaver 7.1 TREX
(TREX 7.1)]

Installation or upgrade to a higher TREX release is only
required if you want to use the full text or attribute
search capabilities of SAP KW.

i Note

TREX 7.1is supported on a restricted number of op-
erating systems. For more information, see the Prod-
uct Availability Matrix (PAM) at http://serv-

ice.sap.com/pam#r .

Check the configuration of your SAP Knowledge Ware-
house. For information about the configuration, see SAP
Note 1287381/ .
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41.6.3 Follow-Up Activities

SAP KW Configuration

For information about the configuration of the SAP Knowledge Warehouse scenarios, see SAP Note 1287381 .

Perform function tests for the SAP KW scenarios

You perform function tests for the SAP Knowledge Warehouse scenarios (such as Editing of Content or Printing of
Structures), which are used in your environment.

If you have a specific version of the SAP KW display component (see Saving Customer-Specific Changes to the
Internet Knowledge Servl [page 75]), then only the SAP standard IKS is available after the upgrade. You have to
apply your changes to the IKS of the target release and deploy them by means of the Software Deployment
Manager (SDM).

4.1.7 Custom Application Development (ABAP)

Use

The Application Server ABAP provides the ABAP foundation of SAP NetWeaver. AS ABAP provides a complete
development and runtime environment for ABAP-based applications. It is optimized for the development of highly
scalable business applications.

SAP delivers a vast number of standard Business applications such as the SAP Business Suite and Industry
solutions, on the ABAP platform, meeting the standard enterprise business requirements. However, there are
always certain processes and scenarios in an enterprise, which are customer-specific. These specific processes
and scenarios enable customers to differentiate their business and further leverage their competitive advantage.
To meet these customer-specific needs the Application Server ABAP development and runtime environment
offers extensive tools and services for the development of ABAP based applications. In addition to the
comprehensive development tools support, the Application Server ABAP also offers capabilities for process &
memory administration, multi-user management, database connections and more.

An end to end lifecycle management support equips customers with services & tools, for example for system
landscape management, configuration, transport management, offering support at every stage of the application
lifecycle, from prototype to go-live and thereafter.

Application Server ABAP 7.4 offers various new enhancements for the Custom Application Development (ABAP)
use case. These new enhancements can be broadly categorized into two main areas:

e Core ABAP enhancements
for example for enhancements in the ABAP programing language, Eclipse-based ABAP development
environment and tools.

e SAP HANA based developments
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to take advantage of SAP HANA specific features from ABAP such as: New ABAP Profiler to detect code
optimization potential for SAP HANA, Enhanced ABAP List Viewer (ALV) for SAP HANA, ABAP managed
database procedures (AMP), Core Data Services (CDS).

The ABAP development and runtime environment makes it possible to develop complex business applications
without having to worry explicitly about technical details such as process or memory administration, multi-user
capability, database connections, or similar issues. These are provided in the basic services of the Application
Server ABAP or are integrated directly in the ABAP runtime. The application development is similarly independent
of the underlying platform. The application server decouples the application coding completely from the operating
system and database that are used. Using ABAP, you can run custom development projects to create and
enhance business functions in the backend, and you can develop applications using various SAP Ul technologies
such as SAP UI5 or Floor Plan Manager (FPM), and Web Dynpro ABAP applications to meet different scenario
requirements.

The Application Server ABAP 7.4 brings with it several innovations and enhancements. The main area of
innovation focus has been on enabling the Application Server ABAP to harness the power of SAP HANA database
for OLAP- and OLTP-based application scenarios. Application Server ABAP 7.4 further on, remains compatible
with traditional relational databases.

The new core ABAP enhancements focus on providing a rich ABAP developer experience

As shown in the figure below, the system landscape provides additional components for the Custom Application
Development scenario:

e SAP HANA database
e ABAP Development Tools for SAP NetWeaver

Design Time Environment

Client

SAP GUI

ABAP Development Tools {Eclipse)

ABAP Platform Layer

Application Server ABAP

Database Layer
Classic DB or SAP HANA DB

Figure 16: Software layers and components that are used in the Custom Application Development scenario

So that optimum benefit can be achieved from running productive Business Suite systems on SAP HANA DB, the
AS ABAP provides support for the migration to SAP HANA DB. A combination of new ABAP code scans as well as
monitoring and analysis tools enables the developer to find ABAP SQL code that has potential for performance
improvement (ABAP for HANA performance optimization).
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With ABAP Development Tools for SAP NetWeaver, a new development environment - as an addition to the ABAP
Workbench (SAP GUI) - is at the disposal of the ABAP developer in the classic Custom Application Development
scenario. It is based on the open platform Eclipse and targets a significant increase in development productivity in
all phases of ABAP-based software projects. It combines the strengths of the close integration of development,
test, and quality-assurance tools with the application server AS ABAP; this includes the stable and proven ABAP
Lifecycle Management process - with the advantages of a comfortable and lightweight Eclipse Ul and a
standardized user interaction process.

ABAP Development Tools play a central role in the integration of the SAP HANA repository contents within the
ABAP platform layer. So that native access to models from the SAP HANA repository is possible from within
ABAP, appropriate proxies can be generated as development objects and handled in the same way as other ABAP
repository objects.

More Information

For more information regarding Custom Application Development (ABAP), see the Help Portal at:

e http://help.sap.com/nw74#% |+ Application Help » Function-Oriented View ¥ Application Server ¥
Application Server ABAP » Application Development on AS ABAP 3

e http://scn.sap.com/community/abap

e http://scn.sap.com/community/netweaver-as

In terms of the implementation of SAP NetWeaver Application Server ABAP 7.4 based on SAP HANA, see the End-
to-End Implementation Roadmap for SAP NetWeaver AS ABAP. This guide is available on the Service Marketplace

at http://service.sap.com/installnw74#%|p Planning 3.

4.2 Configuration of Systems and Follow-Up Activities

After the upgrade, new and changed functions may require you to adjust your Customizing and the configuration
of your systems. For information about new, changed or enhanced functions, see the Release Notes available at

http://help.sap.com/nw74 | What's New — Release Notes 3. In addition, several follow-up activities are
required.

Configuration

The SAP Solution Manager contains descriptions of all configuration tasks, and leads you to automated
configuration procedures, where available.

For more information about configuration activities, check the SAP NetWeaver 74 library at http://help.sap.com/
nw74r|p Application Help » Function-Oriented View » <Software Unit> 1.
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1

Note

Accessing Use Case information in SAP Solution Manager

You can use the business process repository browser (BPR browser) in SAP Solution Manager at https://
implementationcontent.sap.com/bpre to instantly access information about the SAP NetWeaver 7.4 use
cases you want to implement::

Choose ||p Business Process Repository » Solutions/Applications » SAP NetWeaver Jto centrally access
all SAP NetWeaver 7.4 use cases.

Choose |F Business Process Repository » Solutions/Applications » SAP Technology » -> End-To-End Use

Cases Jto access end-to-end implementation information about Application Life-Cycle Management and

Enterprise Data Warehousing.
Process Integration

Instead of creating your configuration guides with the SAP Solution Manager, you can also find the
configuration information in the SAP Help Portal. Access the SAP NetWeaver 74 Library at: http://
help.sap.com/nw74#&|j» Application Help » Function-Oriented View » Process Integration » Configuring

Process Integration After Installation 3.

1. For configuring the Process Integration (PI) Dual Stack, choose | Configuring Process Integration (Pl) Dual

Stack » Basic Configuration for SAP Process Integration (Pl) 3.
o For configuring the Non-Central Advanced Adapter Engine (PI-AF) for PI Dual-Stack, choose

|+ Configuring the Non-Central Advanced Adapter Engine (PI-AF) 4.

2. For configuring the Advanced Adapter Engine Extended (PI-AEX), choose |* Configuring Advanced Adapter

Engine Extended (PI-AEX) #» Basic Configuration for SAP Pl Advanced Adapter Engine Extended .

o For configuring the Advanced Adapter Engine Extended (PI-AF) for AEX, choose | Configuring the
Non-Central Advanced Adapter Engine (PI-AF) for AEX 3.

3. For configuring the Process Orchestration (PI-CP), choose | Configuring Process Orchestration (PI-CP) 3.

Follow-Up Activities

For further follow-up activities, check the section Follow-Up Activities in the Update Guide Update of SAP Systems

Using Software Update Manager <version>. You can find the latest version of this guide at http://

support.sap.com/swdc# | Software Logistics Toolset 1.0 » Documentation ¥ System Maintenance ¥» Updating

SAP Systems Using Software Update Manager <Version> 4.

In addition, for further follow-up activities with regard to SAP NetWeaver key areas such as Process Integration or

Business Warehouse, you need to check the Upgrade and Update Guide - SAP NetWeaver 7.4 <Technology>,
available on the SAP Service Marketplace at http://service.sap.com/upgradenw/4#r .
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A Appendix

Al

Documentation References

The following table contains a list of all documentation referenced in this document and information about where

to find it.

Table 28:

Title

SAP NetWeaver 74 Library

Location

See SAP Help Portal at http://help.sap.com/nw74 #

SUM Guide: Update Guide — Updating SAP Systems Using Soft-
ware Update Manager 1.0 SP<Support Package> <Technology>
<Operating System> <Database>

See SAP Service Marketplace at http://support.sap.com/
sltoolset?r [ System Maintenance » Software Update
Manager (SUM) <version> > Guides for SUM <version> }

Sap NetWeaver 7.4 Update and Upgrade Guides for ABAP,
Java, ABAP+Java: Upgrade and Update Guide - SAP NetWeaver
7.4 <Technology>

See SAP Service Marketplace at http://service.sap.com/
upgradenw74

Maintenance Planning Guide

See http://support.sap.com/mopthvl} section “Guides” ]

Master Guide — SAP NetWeaver 7.4

Installing and Updating TREX 7.1 Single Host

Installing TREX 7.1 Multiple Host

See SAP Service Marketplace at http://service.sap.com/
installnw74
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Title

Migration Guide — SAP NetWeaver Mobile

Location

SAP NetWeaver Upgrade Master Guide
Appendix

PUBLIC

83

®© »w UV >» 0O ® © Wn

- < =

O Z @© O

T + ~+~ T+ 0 © O & — T ~+ 0o X =

® 0 XN N\

-


http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides

Title Location

SAP NetWeaver Upgrade Master Guide
84 PUBLIC Appendix

\"wo§ﬁrD<mcb§~*m2‘U)>(/)V“<'D<mm§~®2‘u>mvawma—-cm-m3—-\30


http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides

Title Location
Upgrade Guide — TREX 6.1 to SAP NetWeaver 7.0 TREX (TREX
7.0)
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Title Location

Upgrade Guide — TREX 7.0 to TREX 7.1 TREX

A.2 Additional Information for Implementing SAP NetWeaver

The following table contains links to information available on SAP Service Marketplace or in the SAP Library which
is relevant for implementing SAP NetWeaver:

Table 29:

Content Location on SAP Service Marketplace or in SAP Library

The latest version of the installation and upgrade guides for http://service.sap.com/instguidesnw74fb
SAP NetWeaver 7.4
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Content

Location on SAP Service Marketplace or in SAP Library

System Copy Guides for different Releases

e SAP NetWeaver 2004:
http://service.sap.com/nwO4installation |l SAP Web

AS 3

o SAP NetWeaver 7.0
http://service.sap.com/installnw70l'hr|} Installation —

SAP NetWeaver Systems 1

® SAP NetWeaver CE 7.1: http://service.sap.com/instgui-
desnwce71fr

o SAP NetWeaver CE 7.1 including enhancement package 1:
http://service.sap.com/instguidesnwce711#%

® SAP NetWeaver CE 7.2: http://service.sap.com/
installnwce72

e SAP NetWeaver Process Integration 7.1: http://serv-
ice.sap.com/installnwpi71#

®  SAP NetWeaver Mobile 7.1: http://service.sap.com/
installnwmobile 71/

Information about security

SAP Security Guide: See the SAP Library at http://
help.sap.com/nw74#& |l Security Information ¥ Security
Guide 3.

Information about the technical operation of SAP NetWeaver

Technical Operations Manual: See the SAP Library at http://
help.sap.com/nw74&|} System Administration and
Maintenance Information » Technical Operations for SAP

NetWeaver ]

Information about SAP NetWeaver Support Package Stacks

http://support.sap.com/sp-stacks#r | SP Stack

Information }

SAP Upgrade Info Center

http://support.sap.com/update

Information about SAP NetWeaver Capabilities

e http://scn.sap.com/community/netweaver fr

e http://scn.sap.com/docs/DOC-8287 ¥

o http://help.sap.com/nw74fhl} Application Help }
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Content Location on SAP Service Marketplace or in SAP Library

SAP Solution Manager Guides All SAP Solution Manager related guides, such as

e Master Guide

e Configuration Guide

e Security Guide Master Guide
e Upgrade Guide

e Solutions Operations Guide

are available at:http://service.sap.com/instguidesfhrw
Installation & Upgrade Guides # SAP Components # SAP

Solution Manager > <Release> }

Information about Maintenance Planning Maintenance Planning Guide at http://support.sap.com/

mopz |l section “Guides” J

A.3 Description of Software Units

The following sections provide more details about product instances, standalone engines, optional standalone
units and clients of SAP NetWeaver.
1 Note
Usage Type, Technical Usage, and Product Instance

The term product instance replaces the terms usage type and technical usage for SAP systems based on SAP
NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1877731 .
Note that there is no terminology change for older releases and all mentioned terms can be used as synonymes.

Caution
Uninstalling additional product instance

Note that it is not possible to uninstall additional product instances and that this is also not supported by SAP.

1 Note

The Composite Voice (CE-VOICE) product instance has been removed with SAP NetWeaver 7.4. For more
information, see: http://help.sap.com/nw74 | Application Help * Function-Oriented View » Composition
Environment » Compatibility and Removed Usage Types 4
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A.3.1 Systems with Product Instances

Java Product Instances

The Java product instances are all based on Application Server Java (BASIC) and in addition require product
instance NW Product Description (NW-MODEL) in the same system. Further dependencies exists that are shown
in the following figure:

Business Process
Management and
Bl Java (BI) Business Rules
Management
(BPM)

Composition

Environment

Platform (CE-
ENV)

Enterprise Portal PDF Export

S Development
Apllication p Adobe Document
Infrastructure

Framework l) Services (ADOBE)
(CE-APPS)

Central Process Enterprise Application EP Core —
Scheduling Services Server Java Application Portal

(JOB-SCHED) Repository (ESR) Extensions (AS) (EPC)

NW Product
Description (NW-
MODEL)

NW Product
Description (NW-
MODEL)

Figure 17: Java Product Instances

For more information and installation instructions, see the SUM guide for Java: Update Guide — Updating SAP
Systems Using Software Update Manager, for: Java, section Installing Additional Product Instances in an Existing
SAP System.

Compatibility Product Instances

Apart from the product instances described here, there are some discontinued product instances. If these
product instances are installed in your source release system, they are preserved during the upgrade. However,
they are not part of a new installation of SAP NetWeaver 7.4. For more information, see Compatibility Product
Instances [page 106].

Adobe Document Services (ADS)
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Adobe Document Services is a set of runtime services that provide a range of form and document creation and
manipulation functions such as:

e Converting XML form templates (created using Adobe LiveCycle Designer) to PDF and various print formats

e Setting Adobe Reader rights to enable users to fill in and annotate forms, save and print them locally, and
include digital signatures for authentication using the free Adobe Reader software

e Fxtracting data from SAP applications into Interactive Forms and transferring form data back into SAP
applications using XML

Dependencies

Adobe document services depends on Application Server Java.

Functional Units

Adobe Document Services comprises the identically named functional unit.
Application Server ABAP (AS ABAP)

SAP NetWeaver Application Server for ABAP provides a complete development and runtime environment for
ABAP-based applications. It is optimized for the development of highly scalable business applications. The ABAP
development environment is used both for developing completely new applications and extending and modifying
SAP standard applications for customers. The entire, powerful infrastructure of the Application Server for ABAP
can be used, which even supports the creation of the most complex applications by large groups of developers.

Application Server Java (BASIC)

AS Java is used to provide the Java foundation of SAP NetWeaver using the Java Engine, a Java EE-compliant
application server for running enterprise applications. In addition to the pure Java EE standard technologies, the
Java Engine implements complementary technologies such as Web Dynpro or Web Services.

Dependencies
AS Java can be combined optionally with other Java-based product instances in one system.
Functional Units

Application Server Java comprises the following functional units:

Table 30:
Functional Unit Description
CM Services (Change Management Services) CM Services help you to manage your Java development.

They provide services for creating development configura-
tions, for importing and exporting, and for the deployment to
runtime systems. CM Services enable you to set up team de-
velopment with centrally managed development configura-
tions. It also supports the automated deployment of build re-
sults on to central runtime system. The import and export
service enables you to import and export Software Compo-
nent Archives (SCAs) of a development configuration. When a
transport system is needed, a development configuration can
be integrated into the Change and Transport System (CTS+).
To use CM Services, product instance Dl is required.
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Functional Unit Description

Java Data Archiving Java Data Archiving provides APIs to allow Java applications

to connect to the XML Data Archiving Service for data archiv-
ing solutions. Java archiving is required for Java applications

with a large volume of retention-relevant data.

Java Foundation This is the Java foundation of SAP NetWeaver. Among its ca-
pabilities is the JEE Engine, a J2EE-compliant application
server for running enterprise applications. In addition to the
pure JEE standard technologies, the JEE Engine implements
complementary technologies, such as Web Dynpro or Web
Services, that are targeted at supporting large-scale, real-
business application development projects.

Services Registry The Services Registry is a registry for Web services. Located
centrally within an SOA landscape, it contains entries for all
services and service definitions in that landscape. The regis-
tered services are classified using semantic-rich classification
systems to enable the browsing of services by classification.

System Landscape Directory The System Landscape Directory (SLD) of SAP NetWeaver
serves as a central information repository for your system
landscape. A system landscape consists of hardware and soft-
ware components that depend on each other with regard to
installation, software updates, and demands on interfaces.
The information in the SLD is used by various SAP tools.

XML Data Archiving Service The XML Data Archiving Service (XML DAS) enables data to
be stored using the WebDAV Storage Interface for the ILM
Solution from SAP as certified in the interface BC-ILM. It al-
lows both XML-sensitive storage used for JAVA Archiving or
XML Archiving (see corresponding Functional units) and ILM
aware archiving used in SAP NetWeaver ILM.

Application Server Java Extensions (AS)

AS Java Extensions enable you to create development components in SAP-specific technologies on top of JEE, for
example, for service composition. In addition, you can enrich standard JEE technologies (such as Enterprise
JavaBeans, Web services, and enterprise applications) with additional SAP-specific capabilities, such as service
group configuration.

Dependencies

AS Java Extensions require AS Java and NW Product Description as a prerequisite in the same system.
Functional Units

AS Java Extensions do not comprise a functional unit.

Bl Java (BI)

Bl Java provides the Java runtime for several BW capabilities.
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Dependencies

Bl Java requires AS Java, NW Product Description, Java Extensions, EP Core — Application Portal, and Enterprise
Portal in the same system. Usually, scenarios running on product instance Bl Java also require product instance
BW ABAP. While installing Bl Java, the required product instances are installed automatically. After configuring Bl
Java, you do not need to perform further steps in AS Java, Java Extensions, EP Core — Application Portal, and
Enterprise Portal.

Functional Units

Bl Java comprises the identically named functional unit.

1 Note

Note that ABAP+Java dual stack systems are not supported with SAP HANA database. For more information
see the End-to-End Implementation Roadmap for SAP BW, powered by SAP HANA on http://service.sap.com/

instguidesnw74#|p Planning 3.

Business Process Management and Business Rules Management

Business Process Management supports the process collaboration and creation of new innovative business
processes based on standardized core processes. SAP Business Process Management enables collaborative
composition of executable business processes based on a process model. Clearly defined business rules can be
incorporated into processes from the outset. The tight integration with Business Rules Management enables
business users with no coding skills to create and modify rules using decision tables.

With Business Rules Management you can author, execute, and manage business rules. The following key
features are offered by Business Rules Management:

® [nference-based rule engine implementing RETE algorithm

e Support of different rules formats (declarative rules, decision table and flow rules)

e Rules Manager: a Web Dynpro Java based rules maintenance tool for business users
e Versioning and tracking changes of business rules

e (Qut-of-the-box Web service generation for rule sets

® Rules testing in the rules composer (NWDS)

e Public API for rules execution

e Tighter integration with Business Process Management

Dependencies

Business Process Management and Business Rule Management requires AS Java, NW Product Description,
Composition Environment Platform and Composite Application Framework in the same system.

Functional Units

Business Process Management and Business Rule Management comprise the following functional units:

Table 31:
Process Server Contains the function for Business Process Management
Rules Server Contains the functions for Business Rules Management
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Business Warehouse ABAP (BW ABAP)
Business Warehouse provides the infrastructure for the following functions:

e Datawarehousing

e Various analytical technologies and functions

e Business planning functions

e \Web-based and Excel-based reporting, analysis, and planning

e [nformation broadcasting to distribute BEx applications via various channels either as precalculated
documents with past data, or as links with live data

e (Open analysis interfaces that make available various interfaces for connecting front-end tools of third-party
providers

Dependencies

BW requires AS ABAP as a prerequisite in the same system.

1 Note

For product instance BW, there is no installation option in the software provisioning manager 1.0.
Instead, you have to install AS ABAP with software provisioning manager 1.0 andthen SAP NetWeaver
7.4 Bl Content Add-On 7.47 SPO5 (or higher) or SAP NetWeaver 7.4 Bl Content Extensions Add-On 7.47 SP0O5
or higher.

Alternatively, there is SAP Netweaver 7.4 Bl Content 7.57 or SAP Netweaver 7.4 Bl Content Extensions Add-On
7.57 available for SAP NetWeaver 7.4 SPS 05 and higher. This version of Bl Content Add-On will be used for
providing additional data flows that make use of the new BW features delivered only from SAP NetWeaver 7.4
SPS 05 and higher. If you use the already existing Bl Content Add-on 7.47 then the limitation is that you would
not receive the data flows based on Netweaver 7.4 SPS05 (and higher) features; it also means that the already
existing Bl Content Add-on 7.47 would not support the new BW features valid only for SAP Netweaver 7.4 SPS
05 and higher. Considering the above limitation we recommend that you upgrade to Bl Content Add-on 7.57.

Central Process Scheduling by Redwood (JOB-SCHED)

SAP Central Process Scheduling adds powerful cross-component scheduling functionality to the integration
capabilities of SAP NetWeaver. SAP Central Process Scheduling has the following key characteristics:

e Centrality
There is only one central instance of this scheduler which takes control over all background processes in the
entire landscape and allows for cross system scheduling.

e Fvent-Driven Scheduling
Dependencies between background processes can be defined not only time based but also event based.

® Real-Time Execution
All information about jobs is stored centrally and transferred to the remote systems immediately before job
submission.

For more information, see SAP Developer Network at http://scn.sap.com/community/cps-by-redwood .
Dependencies

SAP Central Process Scheduling requires Application Server Java and NW Product Description in the same
system.

Functional Units
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SAP Central Process Scheduling comprises the functional unit Integrated Central Process Scheduling by
Redwood.

Composite Application Framework (CE-APPS)

The Composite Application Framework is an abstraction layer that is used to develop all the components required
for the service and object layer of a composite application. These components are:

e Business Objects (Entity Services)

e Business Logic (Application Services)

e Connectivity to external services (Web Services and BAPI/RFC, local and remote persistency)
e Service Provisioning

The Composite Application Framework also provides a comprehensive toolbox that includes the following
features:

e A programming model

o Metadata

e Authorization concepts

e Modeling of relationships between business objects

e |ntegration into lifecycle management using SAP NetWeaver Development Infrastructure

This environment, which is based on a service-oriented architecture (SOA), enables developers to build
applications that leverage the whole SAP NetWeaver technology platform without the need to use low-level APIs.
This way, developers can focus on implementing the business logic of a composite application. The Service
Composer, a graphical modeling tool, provides service simplification and composition. This greatly eliminates the
need to write code for simplification and data mapping.

Dependencies

Composite Application Framework requires Application Server Java and NW Product Description in the same
system.

Functional Units

Composite Application Framework comprises the functional unit Composite Application Framework Runtime
providing the above-mentioned features.

Composition Environment Platform (CE-ENV)

The Composition Environment Platform provides a toolset and runtime for efficiently developing, running, and
managing composite applications based on SOA principles. It builds upon proven technologies that have been
enhanced and integrated to provide greater functionality and flexibility. The Composition Environment Platform
offers you the following capabilities:

e User interface (Ul) development: SAP NetWeaver Web Dynpro and SAP NetWeaver Visual Composer
Web Dynpro and Visual Composer are SAP’s standard Ul technologies based on the Model View Controller
(MVC) for developing user interfaces. Web Dynpro Java or Visual Composer applications are developed within
the SAP NetWeaver Developer Studio using a model-driven approach that minimizes manual Ul coding and
uses visual tools to design and reuse components.

e Business Logic
The Composite Application Framework enables Java business object modeling.

e Service Simplification and Composition
A graphical modeling capability simplifies and adapts Complex Services for easy consumption in Composition
Environment. This greatly eliminates the need to write code for simplification and data mapping.
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Dependencies

Composition Environment Platform requires Application Server Java, NW Product Description, and Composite
Application Framework in the same system.

Functional Units
Composition Environment Platform comprises the following functional units:

Table 32:

Functional Unit Description

Composition Environment Platform Composition Environment Platform is the foundation for
building and running composite applications.

ECM integration core Enterprise Content Management (ECM) Integration Core facil-
itates the provision and consumption of Enterprise Content
Management services using standardized interfaces. There-
fore, it enables business applications to consume core ECM
services provided by SAP as well as extended ECM services
provided by partners and third-party vendors leveraging their
ECM product offering. Besides the core runtime components,
this functional unit contains the service provider interface
(SPI) for exposing ECM services as well as the application pro-
gramming interface (API) for making use of these services.

ECM Integration Services ECM Integration Services offer additional services on top of
ECM Integration Core functional. These supplementary serv-
ices such as the server for World Wide Web Distributed Au-
thoring and Versioning (WebDAV) can be leveraged by appli-
cations on top of the already exposed ECM services of the
connected service providers.

Visual Composer Visual Composer is a model-driven development tool used to
create Ul screens and Portal content using a drag-and-drop
graphical environment, without the need to write code. Using
Visual Composer you can create standalone applications such
as form views and dashboards or Ul screens, such as Web
Dynpro screens. Visual Composer also provides Portal Con-
tent Modeling capabilities for generating roles, pages, iViews
and other content for the SAP NetWeaver Portal.

Portal Provides basic SAP NetWeaver Portal capabilities excluding
the Web Page Composer capabilities, the data statistics tools
of Portal Activity Reports, and the Activity Data Collector.

Universal Worklist Offers users unified and centralized access to their work and
relevant information from within the portal. It collects tasks
and notifications from multiple provider systems — Business
Workflow, Collaboration Task, Alert Framework, and KM Re-
cent Notifications — and displays them in a single list.
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Development Infrastructure (DI)

Development Infrastructure provides an infrastructure for developing Java-based applications on the SAP
NetWeaver platform and enables versioning of source code, build and lifecycle management of these applications.
Dl takes care of all parts of the development process :

1. Version control system for central management of source code: The Design Time Repository (DTR) is a
distributed version control system used in SAP NetWeaver Development Infrastructure to manage source
code in development and lifecycle management processes.

2. Central build and archive management: The Component Build Service (CBS), gives developers access to the
latest archive versions in a central archive storage and a central build triggered by developers or central
lifecycle management processes.

3. Central landscape and transport management: CM Services enables you to set up team development with
centrally managed development configurations. It also supports the automated deployment of build results
on a central runtime system. The import and export service allow you to import and export Software
Component Archives (SCAs) of a development configuration. If a transport system is needed, a development
configuration can be integrated into the enhanced Change and Transport System (CTS+).

You can also use the Change Management Service (CMS), which gives administrators a central service to set
up development landscapes for all development tasks and manage all transport processes for these tasks in
the same Ul. However, note that CMS is planned to be replaced by the CM Services in future releases.
Therefore, we recommend using CM Services.

Dependencies

e Dl requires AS Java and NW Product Description as a prerequisite in the same system. Optionally, it can be
combined with other product instances in one system. However, depending on the size of the development
project and the number of active developers, DI should use a dedicated system. For further details, see SAP
Note 737368 .

You can run the development infrastructure on an AS Java separately from the rest of your runtime systems
in the system landscape for improved scalability.

If you use a development infrastructure, you have to install the Developer Studio feature SAP NetWeaver
Developer Studio Development Infrastructure Client.

Functional Units

DI comprises the functional unit SAP NetWeaver Development Infrastructure providing the above-mentioned
functions.

Enterprise Portal (EP)

Enterprise Portal (EP) provides users with a single, uniform point of access to the applications, services, and
information they need for their daily work. Moreover, the Portal offers business users the features to easily create
and manage portal pages and generate their own content using the following capabilities:

e KM and Web Content Capabilities
EP provides basic document management capabilities and content services within SAP Enterprise Portal
(KM). KM provides the basic capabilities that customers need to run their scenarios, as well as an extension
framework for custom implementations.
These KM capabilities are also integrated into the Web Page Composer environment to enable flexible Web
content management scenarios, bringing relevant information from user-generated content and business
applications together in the portal.

e Portal Add-On with Forums and Wiki Capabilities
On top of EP, you can install the portal add-on including the forums and the wiki application.
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The forums application provides a comprehensive range of discussion features, which are particularly
suitable for community scenarios. Forums typically focus on a specific purpose such as support or human
resources or they might offer customers a place to trade product tips and solutions. Intuitive user interfaces
make it easy for users to ask questions, share information, post announcements to the community, escalate
questions to experts, and to receive updates on posted comments. Users can create draft versions of their
postings, exchange private e-mails with other forum users, and vote in polls.

Wikis provide a framework to easily share and contribute knowledge and information in an intuitive way within
the company. They give employees, customers, suppliers, and partners a framework to collaborative writing,
and help save time by making ideas available, sharing knowledge, and managing related information.

Dependencies

EP requires EPC, AS Java, NW Product Description, and Java Extensions as a prerequisite in the same system.
Optionally, it can be combined with other product instances in one system.

Functional Units

Enterprise Portal comprises the following functional units:

Table 33:
Functional Unit Description
Knowledge Management Enables portal users to distribute, access, and manage un-

structured information within an organization in a heterogene-
ous repository landscape. Capabilities include collaborative
document authoring and publishing, version management,
search and navigation with taxonomies, automated classifica-
tion and subscription, and more.

Collaboration Brings users, information, and applications together to ensure
successful cooperation and interaction in the portal. These
tools include collaboration rooms, instant messaging, e-mail,
and calendar integration.

Enterprise Services Repository (ESR)

The Enterprise Services Repository (ES Repository) provides a central place where enterprise service definitions
are modeled, stored, and maintained. It supports SAP's concept of building services based on the process
component modeling methodology. The ES Repository offers the following features:

e Support of governed definitions of SOA assets (such as services and data types).

e Support of widely adopted open standards including Web Services and UDDI.
The ES Repository supports SAP-defined Global Data Types based on the Core Component Technical
Specification standards (stack) (CCTS standards (stack)).

® Basis for enabling easy access to enterprise services - described with rich business classifications - when
developing composite applications and business processes.

Dependencies
Enterprise Services Repository requires Application Server Java in the same system.
Functional Units

Enterprise Services Repository comprises the identically named functional unit providing the above mentioned
capabilities.
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EP Core — Application Portal (EPC)

EP Core — Application Portal (EPC) provides the basic portal capabilities for SAP NetWeaver. It provides a uniform
entry point to content and applications in a consistent, role-based manner. It offers a single point of access
through a Web front end to SAP and non-SAP information sources, enterprise applications, information
repositories, databases and services across organizational and technical boundaries - all integrated into a single
user experience. EPC alone provides a leaner portal installation and implementation where the full enterprise
portal capabilities (such as knowledge management tools) are not needed.

The EPC product instance contains the following capabilities that will help you manage your content and
processes:

e The core portal capabilities include various tools and service for managing portal content, users, and
connections to connected systems such as Single-Sign-On, tools for application integration, roles and
permissions, changing the portal look and feel with the new Ajax Framework, and lifecycle management
(transport).

e |ntegration of several SAP Enterprise Portals and third-party portals into one harmonized SAP Enterprise
Portal acting as the single point of access to all the business related applications and services in the
organization.

e \Web Page Composer (WPC): this is an integral part of EPC providing powerful capabilities for business users
to easily create and manage enriched portal pages. Web Page Composer supports professionals creating
interactive portal pages.

Dependencies
EPC requires AS Java and NW Product Description as a prerequisite in the same system.
Functional Units

EP Core — Application Portal comprises the following functional units:

Table 34:
Functional Unit Description
Portal Provides basic SAP Enterprise Portal capabilities
Universal Worklist Provides the Universal Worklist Capabilities

Mobile

Product instance Mobile is used to enable field personnel to participate in a business process in an “occasionally
connected” mode. Occasionally connected means that a direct connection (using WLAN or GPRS) between the
mobile device and back end is only established at certain times — at synchronization points, when the Mobile
Server (that is, the system with product instance Mobile) and Mobile Client exchange data in order to keep the
server and client updated. This enables the user to perform process tasks completely independently from the
back-end system, which is extremely helpful if a steady connection cannot be guaranteed or might be too
expensive. To realize this product instance, an intelligent application needs to run on each device containing a
user interface, business logic, and data handling. Mobile includes the Data Orchestration Engine (DOE), an ABAP-
based message-oriented middleware. The Data Orchestration Engine consists of the following:

e Adesign time tool for defining data objects and the distribution of data.

e Aruntime to replicate, synchronize and distribute data between the components of the system landscape.
This includes, for example, messaging, filling queues, and sending data to the back end.

Dependencies
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Mobile is not an installable software unit. As of SAP enhancement package 1 for SAP NetWeaver 7.3, SAP
NetWeaver Mobile is available as add-on. To set up a Mobile system, you install and configure AS ABAP. On top of
the AS ABAP system, you install and configure the SAP NetWeaver Mobile add-on separately.

NW Product Description (NW-MODEL)

NW Product Description contains metadata for SAP NetWeaver, for example, about comprised software
components and their interdependencies. NW Product Description is always included when you install a Java
product instance.

PDF Export

With PDF Export, you can create print versions of lists that are displayed using ALV for Web Dynpro for ABAP
(SAP List Viewer) and ALV for Web Dynpro for Java.

Dependencies
PDF Export depends on Adobe Document Services, Application Server Java and NW Product Description.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Pl requires AS ABAP, AS Java, NW Product Description, AS Java Extensions, Pl Adapter Engine, and Enterprise
Services Repository as a prerequisite in the same system.

For installing P, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated Pl system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units
Process Integration comprises the functional unit SAP Process Integration.
Restrictions for Systems with Multiple Product Instances

e |f you have one system with multiple product instances, be aware that we do not provide standard tools for
separating these product instances and distribute them to multiple systems at a later stage. For example, if
you have a system with product instances A and B, you are not able to migrate it with SAP standard tools into
two systems, one with product instance A only and the other with product instance B only.

In addition, we do not provide standard tools for merging multiple systems with different product instances
into one system with multiple product instances at a later stage. If you want to perform these tasks, you
require specific project support. The only exception is the dual-stack split procedure that offers to split an
optional dual-stack system into two separate systems: one based on AS ABAP, the other one based on AS
Java. For more information about the dual-stack split, see http://scn.sap.com/docs/DOC-25162 ¥ .
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The following figure shows that SAP standard system copy and migration tools do not support you in
separating or merging systems with product instances:

Figure 18: Separating systems with product instances are not supported with SAP standard system copy and migration
tools

Figure 19: Merging systems with product instances are not supported with SAP standard system copy and migration tools

e Although you can use one system for multiple product instances, client restrictions apply to product instance

BW ABAP. For BW ABAP, you should reserve a dedicated client for reporting purposes. In this client, activate
the SAP NetWeaver Bl Content Add-On as required.

A.3.2 Optional Standalone Units

Advanced Adapter Engine (Pl Adapter Engine)

You use the Advanced Adapter Engine to connect to SAP systems (RFC adapter, IDoc Adapter, and ABAP
proxies) and external systems. You use the various adapters in Pl Adapter Engine to convert XML- and HTTP-
based messages to the specific protocol and format required by these systems, and the other way around.
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You can use the following adapters:

e RFC Adapter

e SAP Business Connector Adapter

e File/FTP Adapter

e JDBC Adapter

e JMS Adapter

e SOAP Adapter

e Marketplace Adapter

e Mail Adapter

e RNIF Adapter

e CDIX Adapter

e |Doc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
e HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)

You can use the Advanced Adapter Engine which is included in the Pl system as a central adapter engine.
Optionally, for performance reasons, you can install a non-central Advanced Adapter Engine on a separate host.

Dependencies

The Advanced Adapter Engine requires AS Java, NW Product Description, and AS Java Extensions as a
prerequisite in the same system. These product instances are automatically installed when you install the
Advanced Adapter Engine.

Functional Units
The Advanced Adapter Engine comprises the functional unit Advanced Adapter Engine.
Advanced Adapter Engine Extended

The installation option Advanced Adapter Engine Extended (AEX) consists of core components to model, design,
automate, and integrate processes in one or more application systems. The Advanced Adapter Engine Extended
provides the following capabilities:

e (Connectivity capabilities of the Advanced Adapter Engine (AAE)

e Design and configuration tools to set up scenarios that are based on the AAE. In particular, for design and
configuration you can use the ES Repository and the Integration Directory. The Integration Directory installed
with AEX contains a subset of configuration options required for the configuration of message processing by
the AAE, basically the integrated configuration.

e Mediation capabilities of AAE
You can use the following adapters:
o RFC Adapter
o  SAP Business Connector Adapter
o File/FTP Adapter
o JDBC Adapter
o JMS Adapter
o SOAP Adapter
o Marketplace Adapter
o Mail Adapter
o RNIF Adapter
o CDIX Adapter
o |IDoc Adapter (Advanced Adapter Engine) (adapter type IDOC_AAE
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o HTTP Adapter (Advanced Adapter Engine) (adapter type HTTP_AAE)
Dependencies

Advanced Adapter Engine Extended requires AS Java, NW Product Description AS Java Extensions, Pl Adapter
Engine, and Enterprise Services Repository as a prerequisite in the same system.

Functional Units
Advanced Adapter Engine Extended comprises the identically named functional unit.
Process Integration (PI)

Pl consists of core components that model, design, automate, and integrate processes in one or more application
systems. For the integration of internal and cross-company processes, Pl is used to incorporate all the functions
of what was formerly known as Exchange Infrastructure (XI). In addition, Pl contains core components for cross-
component Business Process Management (ccBPM) for application-embedded and application-unbounded
processes.

Dependencies

Pl requires AS ABAP, AS Java, NW Product Description, AS Java Extensions, Pl Adapter Engine, and Enterprise
Services Repository as a prerequisite in the same system.

For installing PI, it is mandatory to have a dedicated Pl system. This applies to development, quality, and
production landscapes. It is a prerequisite that no other system in your system landscape has a higher release
and enhancement package level than the Pl system. If you want to upgrade or install an application in your system
landscape, you first have to make sure that the current release and enhancement package level of the Pl system is
on the same level - if required, you have to upgrade the Pl system first to the new or a higher release. In a
dedicated Pl system, this can be accomplished with a minimum of downtime. Also, the Pl system would not be
affected by the downtime of other product instances running in the same system.

Functional Units

Process Integration comprises the functional unit SAP Process Integration.

A.3.3 Standalone Engines

For SAP NetWeaver, the following standalone engines are available:
Adapter Engine Java SE

Adapter Engine (Java SE) is a separate software unit. You can use it only if you have SAP NetWeaver systems with
product instance Pl in your system landscape. It has to be installed manually. You use the Adapter Engine (Java
SE) to connect to external systems. Using the various adapters in the Adapter Engine (Java SE), XML and HTTP-
based messages can be converted to the specific protocol and format required by such systems, and the other
way around. The Adapter Engine (Java SE) only provides some of these adapters as a standalone version with
restricted functions for operating systems that do not support SAP PI, but that have at least a Java Runtime
Environment 5.0. Therefore, you should use the Adapter Engine (Java SE) only if the platform prerequisites do not
allow you to use the Advanced Adapter Engine.

Content Server

Content Server is a separate server instance that is used to store documents or other types of content related to
SAP applications. The accompanying cache server can cache content if your company operates in several
locations. This reduces load on the wide area network when working with documents.
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SAP Gateway Foundation

As of SAP NetWeaver 7.4 the central software components of SAP Gateway have been directly integrated into
SAP NetWeaver in the form of software component SAP Gateway Foundation (SAP_GWFND). This component is
automatically part of SAP NetWeaver 7.4 and higher.

SAP Gateway Foundation facilitates easier provisioning and consumption of business logic and content of SAP
back-end systems for mobile and web applications. It aims to reduce the complexity and the skill set required to
access SAP data, thereby removing deployment barriers. Simple interfaces also help to shorten development
times.

SAP Gateway Foundation enables people-centric applications to consume SAP Business Suite data through
popular platforms and devices (such as the iPad and Blackberry) in an easy and standards-based manner. Itis a
framework that connects business users to SAP systems using consumer technologies, groupware, and mobile
devices and is based on open standards (such as the Atom Publishing Protocol and OData) that offer simple
services based on the REST principle.

Depending on your development requirements and where you want to develop SAP Gateway Foundation content,
you can install SAP NetWeaver in either an SAP Business Suite back-end system (embedded deployment) or in an
SAP Gateway Foundation hub system (central hub deployment).

For more information, see http://help.sap.com/netweaverl SAP NetWeaver Platform ¥ SAP NetWeaver <your
release> # Application Help » Function-Oriented View » SAP Gateway Foundation (SAP_GWFND) 3.

liveCache

liveCache is a database engine for managing complex objects in scenarios where large volumes of data must be
permanently available and modifiable.

Search and Classification (TREX)

SAP NetWeaver Search and Classification (TREX) offers an integrated set of services. TREX services include
search and retrieval in large document collections, text mining, automatic document classification, and search
and aggregation over structured data in SAP applications. TREX can handle text from documents in numerous
formats, including Microsoft Office and Adobe formats (PDF), and more than 30 languages. TREX search options,
such as exact, Boolean, fuzzy, or linguistic search, and classification options such as query-based or example-
based classification, offer great power and flexibility to end users.

The BW accelerator is based on TREX technology. You need an installation based on 64-bit architecture for the
BW accelerator. The hardware partners provide this variant already preconfigured as the BW accelerator box.
Note that a TREX installation configured for searching in metadata and documents based on 32-bit architecture
cannot be used for the BW accelerator. Accordingly, a BW accelerator box also cannot be used for searching in
metadata and documents. In order to be able to use the search function and the BW accelerator, you need
separate installations.

Web Dispatcher

The Web Dispatcher lies between the Internet and your SAP system. It is the entry point for HTTP(s) requests into
your system, which consists of one or more SAP NetWeaver application servers. As a software Web switch, the
Web dispatcher can reject connections or accept them. When it accepts a connection, it balances the load to
ensure even distribution across the servers.

You can use the Web dispatcher in ABAP/Java systems and in pure Java systems, as well as in pure ABAP
systems.
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Itis also beneficial to use the Web Dispatcher if you do not need security functions (entry point in the demilitarized
zone (DMZ), SSL, URL filtering), but you simply want to balance the load between multiple SAP NetWeaver
Application Server instances.

Since Web Dispatcher is optional for every SAP system, it is not contained in the system landscapes of the use
cases in this documentation.

For more information, see the SAP Library at http://help.sap.com/nw74#% | Application Help » SAP Function-
Oriented View ¥ Application Server ¥ Application Server Infrastructure » SAP Web Dispatcher 3.

A.3.4 Clients

With SAP NetWeaver, you can use the front-end clients and tools described below:
Adobe LiveCycle Designer

Adobe LiveCycle Designer enables the creation of forms that combine high-fidelity presentation with XML data
handling. The easy-to-use graphical interface of Adobe LiveCycle Designer enables users to quickly design forms,
maintain form templates, define a form's business logic, make changes, and preview forms before they are
deployed as Adobe PDF files.

SAP NetWeaver Business Client

The SAP NetWeaver Business Client (NWBC) is a high fidelity desktop client that allows users to display their
assigned roles and to launch applications. SAP NetWeaver Business Client offers a unified environment for and a
single point of entry to SAP business applications and technologies. NWBC is ideal for displaying business
applications such as classical SAP GUI Uls, Web Dynpro Uls, BSP pages, and other content using its multiple
rendering engines. NWBC provides role-based access to applications either via the portal or directly using PFCG
roles. In addition to the basic capabilities detailed above, the SAP NetWeaver Business Client makes use of its
tight desktop integration to provide additional benefits such as desktop search functionality. In the newest SAP
NetWeaver Business Client version you will find the improved user interface (Ul) based on the SAP Signature
design. This Ul offers in part an expert-based interactive paradigm and a superior look and feel matching the
expectations of today's users aiming to maximize their daily activities.

The SAP NetWeaver Business Client is one of the main components of the User Interface Add-On for SAP
NetWeaver. For more information, see the SAP Help Portal at http://help.sap.com/nw-uiaddon# |l Application

Help 3.
Business Explorer (Bl Add-On)

Business Explorer provides flexible reporting and analysis tools for strategic analyses and decision-making
support within a company. These tools include query, reporting, and analysis functions. As an employee with
access authorization, you can evaluate past or current data on various levels of detail and from different
perspectives, not only on the Web but also in Microsoft Excel.

You can use Business Explorer Information Broadcasting to distribute Business Intelligence content by e-mail
either as precalculated documents with historical data, or as links with live data. You can also publish it to the SAP
Enterprise Portal.

Additionally to Business Explorer you may want to consider using tools from the SAP BusinessObjects Analysis
family, such as Analysis, edition for Microsoft Office. The SAP BusinessObjects Analysis clients are specifically
designed for the needs of BW users. Note that SAP BusinessObjects products require separate licenses.
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SAP GUI

SAP offers three different client applications for accessing ABAP applications in SAP systems (such as SAP
NetWeaver systems with product instance AS ABAP). This SAP GUI family consists of:

e SAP GUI for HTML
SAP GUI for HTML is based on the SAP integrated Internet Transaction Server (ITS) which is included in the
installation of SAP NetWeaver systems as of SAP NetWeaver 7.0. On the client side, only a suitable browser
and a virtual machine are required. For information about supported browser versions, see the Product
Availability Matrix on SAP Service Marketplace at http://support.sap.com/pam# .

e SAP GUI for the Java environment (SAP GUI for Java)
SAP GUI for Java is a generic SAP GUI that covers a variety of platforms.
For more information about the installation of SAP GUI for Java, see the documentation Installation Guide —
SAP Front End.

e SAP GUI for the Windows environment (SAP GUI for Windows)
SAP GUI for Windows is SAP's universal client for accessing all SAP applications built on ABAP technology. It
is available on the Microsoft Windows platform only and offers the broadest feature set of all members of the
SAP GUI family.
For more information about the installation of SAP GUI for Windows, see the Installation Guide — SAP Front
End.

SAP GUI also includes optional add-ons, such as the Business Explorer (Bl add-on) and KW add-on, which might
be required to use certain SAP NetWeaver capabilities.

1 Note

Data warehousing: SAP GUI for HTML and SAP GUI for Java do not have all the capabilities of SAP GUI for
Windows. BEx Query Designer, BEx Analyzer and Uls with network controls are not supported with SAP GUI for
HTML and SAP GUI for Java.

The following SAP GUI versions are supported with SAP NetWeaver 7.4:

e SAP GUI for Windows 7.30 (or higher)
e SAP GUI for Java 7.30 (or higher)
e SAPintegrated ITS

For more information about the SAP GUI family, see SAP Community Network at http://scn.sap.com/
community/gui.

Mobile Client

Mobile Client is installed locally on mobile devices, and is equipped with a Web server, a database layer, and a
framework for the mobile applications. Staff working remotely can therefore work offline and do not have to wait
for a network connection to complete time-critical business applications. Product instance Mobile offers tools for
synchronization and data replication that make the data of the mobile device consistent with that of the back-end
system.

Modeling Tools for SAP BW powered by SAP HANA

The Modeling Tools for SAP BW powered by SAP HANA (BW Modeling Tools) represents a new modeling IDE
(Integrated Development Environment) build on top of the Eclipse platform.

Its main objective is to support BW model developers in today's increasingly complex Bl environments by offering
state-of-the-art modeling tools. These tools include integration with SAP HANA modeling and the consumption of
HANA elements in BW Open ODS Views or CompositeProviders with powerful Ul (user interface) capabilities.
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SAP NetWeaver Developer Studio

The SAP NetWeaver Developer Studio (NWDS) is SAP's Integrated Development Environment (IDE) for Java and
is based on the open-source tools framework Eclipse 3.5. With the SAP NetWeaver Developer Studio, you can
develop Java EE 5 applications from scratch using the built-in support for new technologies such as EJB 3.0 and
JSF1.2.

1 Note
NWDS 7.3 EHP1 as development environment for NetWeaver 7.4

Since SAP NetWeaver Developer Studio 7.4 is not available, you can use the SAP NetWeaver Developer Studio
of the latest Support Package of SAP enhancement package 1 for NetWeaver 7.3 as development environment
for SAP NetWeaver 7.4. For more information, see SAP Note 1791485 .

SAP Enterprise Services Explorer Tool for Microsoft .NET

As part of its service-oriented architecture (SOA) offering, SAP provides a set of consumer tools that allow the
discovery and consumption of enterprise services from various development environments, such as NetWeaver
Developer Studio, Visual Composer, and Microsoft Visual Studio. SAP Enterprise Services Explorer tool for
Microsoft .NET (ES Explorer for .NET) is an add-on for Microsoft Visual Studio 2005 and Microsoft Visual Studio
2008 that helps to leverage SOA by enabling .NET developers to discover SAP enterprise services and consume
them in their applications, as well as publish their own custom services. It is an important element of SAP -
Microsoft interoperability.

To download the tool, access documentation and other resources, see http://scn.sap.com/community/
interoperability/microsoft-net .

For the most up-to-date information about ES Explorer for .NET, see SAP note 1259258 #r .

A.4 Compatibility Product Instances

Compatibility product instances are product instances that have been discontinued and are therefore not part of
the standard SAP NetWeaver installation. If you upgrade from a previous release, these product instances will of
course still exist in your systems if they have been present in the source release system.

There might be reasons for which you want to install these product instances. You can do this using the Software
Update Manager. Note that you can install these product instances only on existing SAP NetWeaver 7.4 Java
systems with at least product instance AS Java.

For more information and installation instructions, see the SUM guide for Java: Update Guide — Updating SAP
Systems Using Software Update Manager, for: Java, section Installing Additional Product Instances in an Existing
SAP System.

Demo Applications

Demo Applications illustrate the usage of SAP Composition Environment for previous releases.
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Guided Procedures

Guided Procedures is a framework for modeling and managing workflows using simple and user-friendly tools.
Guided Procedures enables access to multiple backend systems, consistently combining different types of
services and applications into processes. In addition, Guided Procedures supports collaboration, ad-hoc items,
and offline task management using interactive forms. It provides role-based access to tools and resources and
guidance through the workflows at runtime, thereby helping end users to easily identify and complete their tasks.

Dependencies

Guided Procedures require Application Server Java, Composition Application Framework, Composition
Environment Platform as a prerequisite in the same system.

Functional Units

Guided Procedures comprise the identically named functional unit providing the above mentioned capabilities.

NWDS Update Site

You use the NWDS update site when you develop composite applications using several Developer Studio
installations. An update site contains all features for the Developer Studio. You can initiate a check for updates or
additional features in the Developer Studio and install them when available. The update site capability mirrors the
SAP Developer Studio update site on SAP Service Marketplace for an improved update performance. It does not
run on a multi-node cluster.

The NWDS update site has been replaced by an Eclipse-based solution.
Dependencies

NWDS update site requires Application Server Java as a prerequisite in the same system.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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